The ultimate
Pascal development
environment

Incredibly fast—
compiles more

than 72,000 lines
a minute!




TURBO

PASGAL ...

Borland’s No-Nonsense License Statement!
This software is protected by both United States copyright law and international treaty provisions.
Therefore, you must treat this software just like a book, with the following single exception. Borland
International authorizes you to make archival copies of the software for the sole purpose of backing-up our
software and protecting your investment from loss.

By saying, “just like a book," Borland means, for example, that this software may be used by any number of
people and may be freely moved from one computer location to another, so long as there is no possibility of
it being used at one location while it's being used at another. Just like a book that can't be read by two
different people in two different places at the same time, neither can the software be used by two different
people in two different places at the same time. (Unless, of course, Borland's copyright has been violated.)

Programs that you write and compile using Turbo Pascal for the Mac may be used, given away, or sold
without additional license or fees. You are not required to indicate that your programs were developed
using Turbo Pascal for the Mac, or that they contain source code provided with Borland language products
(toolboxes).

The sample programs on the Turbo Pascal for the Mac diskette provide a demonstration of the various
features of Turbo Pascal for the Mac. They are intended for educational purposes only. Borland International
grants you (the registered owner of Turbo Pascal for the Mac) the right to edit or modify these sample
programs for your own use, but you may not give them away or sell them, alone or as part of any program, in
object or source code form. You may, however, incorporate miscellaneous sample program routines into
your programs, as long as your resulting programs do not substantially duplicate all or part of a sample
program in appearance or functionality.

WARRANTY

With respect to the physical diskette and physical documentation enclosed herein, Borland International,
Inc. ("Borland”) warrants the same to be free of defects in materials and workmanship for a period of 60 days
from the date of purchase. In the event of notification within the warranty period of defects in material or
workmanship, Borland will replace the defective diskette or documentation. If you need to return a product,
call the Borland Customer Service Department to obtain a return authorization number. The remedy for
breach of this warranty shall be limited to replacement and shall not encompass any other damages, including
but not limited to loss of profit, and special, incidental, consequential, or other similar claims.

Borland International, Inc. specifically disclaims all other warranties, expressed or implied, including but not
limited to implied warranties of merchantability and fitness for a particular purpose with respect to defects in
the diskette and documentation, and the program license granted herein in particular, and without limiting
operation of the program license with respect to any particular application, use, or purpose. In no event shall
Borland be liable for any loss of profit or any other commercial damage, including but not limited to special,
incidental, consequential or other damages.

GOVERNING LAW

This statement shall be construed, interpreted, and governed by the laws of the state of California.

First Edition
Printed in USA
98 76 54 3 2



READ Mg BST

In order to provide you with the latest technical mforr@ ur products, announcements of future updates, and
up-to-the-minute information on new products, plea and return this registration form. Be sure to read the
Borland No-Nonsense License Statement on the o r snd

Technical Support—To receive telephone ech | support, you must be a registered owner of the Borland
product about which you are calling. Prompt techpigtl su;%n is available through the Borland SIG on CompuServe; just
type GO BOR at any CompuServe prompt. If yo r assistance, call Borland and be prepared to give the product
name, version number, and the serial number, the label of your master diskette.

The README File—Ifpresentony gast kette, this file contains important information that may not be in
the manual. To view this file, simply type R P]éthe command prompt. Be sure to read this file before you call for
technical support.

Thank you for completing this product registration card and returning it promptly. We want to keep you informed.

Product Name: Serial # —_ Date Purchased: _MI_D/_
Name: Title:
last first middle init.
Company Name: Department:
Address: Mail Stop:
City: State: Zip: Country: ——_______Phone # (. ) -

| have read and agree to the terms of the Borland No-Nonsense License Statement

Signature Date: —_/___/____
In order to help us better serve your needs, please complete the following:

Nature of your business or occupation:

I. O health 2. O manufacturing 3. O business 4. O programming
5. O construction 6. O retail/wholesale 7. O services 8. O education

9. O legal 10. O consulting 11. O finance 12. O transportation
13. O government O other

Number of 1

1.0 1-24 2 0O 25-99 3. O 100-499 4. O 500-1999 5. O 2000-9999 6. O more than 9999
Number of PCs at your business:

.ai-9 2.0 10-49 3. O 50-249 4. O 250-999 S. O more than 999
What other Borland products do you own?

1. O Turbo Pascal 2. O Pascal Toolboxes 3. O SideKick

4. O SuperKey S. O Reflex 6. O Traveling SideKick

7. O Turbo Lightning 8. O Turbo Prolog O other
Where did you purchase this program?

1. O Borland mail order 2. O other mail order 3. O full-service retailer

4. O discount retailer O other
What hardware peripherals do you use?

1. O modem 2. O hard disk 3. 0 EGA card

4. O dot matrix 5. O plotter 6. O mouse
This software was bought for:

1.0 self 2. O company | work for 3. O company | own
Where will you use this program?.

1. O at home 2. 0 atwork O other
Where did you hear about this program?

I. O ad in computer publication 2. O product review 3. O.retailer

4. O ad in general interest publication S. O trade show 6. O another user

O other

What other software do you use?

1. O spreadsheet 2. O database 3. O word processor 4. O utilities

5. O project mgmt. 6. O communications 7. O games 8. O languages

9. O accounting 10. O network I'1. O business graphics 12. O CAD/CAM
13. O RAM-resident utilities O other
What software would you consider buying from Borland?

1. O spreadsheet 2. O database 3. O word processor 4. O utilities

5. O project mgmt. 6. O communications 7. O games 8. 0O languages

9. O accounting 10. O network 1. O business graphics 12. O CAD/CAM
13. O RAM-resident utilities O other

BOR0045B



Turbo Pascal for the Mac

Borland’s No-Nonsense License Statement!
This software is protected by both United States copyright law and international treaty provisions. Therefore, you must treat this software just like a book, with
the following single exception. Borland International authorizes you to make archival copies of the software for the sole purpose of backing-up our software
and protecting your investment from loss.

By saying, “just like a book," Borland means, for example, that this software may be used by any number of people and may be freely moved from one computer
location to another, so long as there is no possibility of it being used at one location while it's being used at another. Just like a book that can't be read by two
different people in two different places at the same time, neither can the software be used by two different people in two different places at the same time.
(Unless, of course, Borland's copyright has been violated.)

Programs that you write and compile using Turbo Pascal for the Mac may be used, given away, or sold without additional license or fees. You are not required
to indicate that your programs were developed using Turbo Pascal for the Mac, or that they contain source code provided with Borland language products
(toolboxes).

The sample programs on the Turbo Pascal for the Mac diskette provide a demonstration of the various features of Turbo Pascal for the Mac. They are intended
for educational purposes only. Borland International grants you (the registered owner of Turbo Pascal for the Mac) the right to edit or modify these sample
programs for your own use, but you may not give them away or sell them, alone or as part of any program, in object or source code form. You may, however,
incorporate miscellaneous sample program routines into your programs, as long as your resulting programs do not substantially duplicate all or part of a sample
program in appearance or functionality.

WARRANTY

With respect to the physical diskette and physical documentation enclosed herein, Borland International, Inc. (“Borland”) warrants the same to be free of
defects in materials and workmanship for a period of 60 days from the date of purchase. In the event of notification within the warranty period of defects in
material or workmanship, Borland will replace the defective diskette or documentation. If you need to return a product, call the Borland Customer Service
Department to obtain a return authorization number. The remedy for breach of this warranty shall be limited to replacement and shall not encompass any
other damages, including but not limited to loss of profit, and special, incidental, consequential, or other similar claims.

Borland International, Inc. specifically disclaims all other warranties, expressed or implied, including but not limited to implied warranties of merchantability and
fitness for a particular purpose with respect to defects in the diskette and documentation, and the program license granted herein in particular, and without
limiting operation of the program license with respect to any particular application, use, or purpose. In no event shall Borland be liable for any loss of profit or
any other commercial damage, including but not limited to special, incidental, consequential or other damages.

GOVERNING LAW

This statement shall be construed, interpreted, and governed by the laws of the state of California.
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Introduction

Welcome to Turbo Pascal for the Mac. The programming language Turbo Pascal
is designed to meet the needs of all types of Macintosh users: It’s a structured,
high-level language that can be used to write programs for almost any
application.

This manual walks novice programmers through writing, compiling, and sav-
ing Turbo Pascal programs. It also teaches you how to take existing Pascal pro-
grams and run them under Turbo Pascal.

Sample programs are provided on your distribution disks for you to study and
practice on. You can also tailor these sample exercises to your particular needs.

You should be somewhat familiar with the basics of operating a Macintosh
before you start this manual. That is, you should know about clicking on icons,
using the mouse, opening folders, and other Macintosh features. If you're not
comfortable with these terms, spend some time playing with your Mac and using
your Macintosh’s user’s guide. You may also want to skim through the glossary at
the end of this manual to get some understanding of the concepts we've used.



The Manual

This manual is divided into three main sections: the User’s Guide (Part I), the
Reference Section (Part II), and the Appendices. A glossary and index round out
the manual.

The User’s Guide introduces you to Turbo Pascal, shows you how to use it, and
includes chapters that focus on such specific features as units, desk accessories,
and debugging. Here’s a breakdown of the chapters:

Chapter 1: Setting Up shows you how to set up your Mac for Turbo Pascal,
describes the files on your distribution disk, and explains how to make backup
disks.

Chapter 2: Getting Started with Turbo Pascal leads you directly from loading
Turbo Pascal into writing simple programs. It then suggests how you should go

about reading the rest of the manual, depending on your familiarity with the Mac
and with Pascal.

Chapter 3: Using the Editor explains Turbo Pascal’s menus (except for the Com-
pile menu, covered in the next chapter) and shows you how to use the editor to
open, edit, change, and save files.

Chapter 4: Using the Compiler describes how to implement the programs you
learned to create in Chapter 3, using the compiler. It also shows you common
programming errors and how to avoid them.

Chapter 5: Writing Textbook Pascal Programs shows you how to take standard
Pascal programs and use them with Turbo Pascal without having to know any-
thing about the Macintosh Toolbox and operating system.

Chapter 6: Harnessing the Full Power of Your Mac is a quick guide to the
Macintosh and the tools that exist to help you write more complex programs.

Chapter 7: Units and Other Mysteries tells you what a unit is, how it’s used,
and what predefined units (libraries) Turbo Pascal provides.

Chapter 8: Writing Your Own Units goes into the general structure of a unit and
its interface and implementation portions. It shows you how to initialize and
compile a unit.

Chapter 9: Writing Your Own Macintosh Applications shows you how to put
together your own Mac-style programs, complete with menus, windows, and
cursors.

Chapter 10: Graduation: Writing a Desk Accessory tells you all you need to
know to design and write desk accessory programs.
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Chapter 11: UNITMOVER, Chapter 12: RMAKER, and Chapter 13: FONT/DA
MOVER give detailed instructions on these utilities, which come on your Turbo
Pascal disks.

Chapter 14: Debugging Your Turbo Pascal Program explains how to use
MACSBUG to check for errors in your program.

Chapter 15: The Turbo Pascal Menu Reference is a complete guide to the menu
commands in Turbo Pascal.

Now we move on to the Reference Section of the manual. The first 11 chapters
offer technical information on the following features:

Chapter 16: Tokens and Constants

Chapter 17: Blocks, Locality, and Scope
Chapter 18: Types

Chapter 19: Variables

Chapter 20: Expressions

Chapter 21: Statements

Chapter 22: Procedures and Functions

Chapter 23: Programs and Units

Chapter 24: Input and Output

Chapter 25: Standard Procedures and Functions
Chapter 26: The Standard Apple Numeric Environment (SANE) Library

Chapter 27: Inside Turbo Pascal offers additional technical information for
advanced Pascal programmers, including internal data formats, assembly-lan-
guage interfaces, and user-defined device drivers.

Finally, there are six appendices in the manual:

Appendix A: Comparing Turbo Pascal with Other Pascals
Appendix B: Error Messages and Codes

Appendix C: Compiler Directives

Appendix D: Macintosh Interface Units

Appendix E: Macintosh Character Set

Appendix F: TURTLEGRAPHICS: Mac Graphics Made Easier

Typography

The use of italic and boldface type in this manual follows certain conventions.
Reserved words are set in lowercase, boldface type. Constant identifiers, field
identifiers, and formal parameter identifiers are italicized when referred to
within text. Other identifiers—unit and program names, labels, types, variables,
procedures, and functions—begin with an uppercase letter; they also are itali-
cized when referred to within text.
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The command key (the cloverleaf key on the Mac keyboard) is represented by
the keycap (&).

Pascal syntax is illustrated by diagrams. To follow a syntax diagram, start at the
top left and follow the arrows through the diagram. Alternative paths are often
possible; paths that begin at the left and end with an arrowhead on the right are
valid paths. A path traverses boxes that hold the names of elements that are used
to construct that portion of the syntax.

The names in rectangular boxes stand for actual constructions. Those in circu-
lar boxes—reserved words, operators, and punctuation—are the actual terms
that should be used in the program.

Acknowledgments

Apple® is registered to Apple Computer, Inc.

Macintosh™ is a trademark licensed to Apple Computer, Inc.
Inside Macintosh®© is a copyright of Apple Computer, Inc.
Lisa® is a registered trademark of Apple Computer, Inc.
Lisa®Pascal™ is a trademark of Aioi Seiki Kabushiki.

How to Contact Borland

If, after reading this manual and using Turbo Pascal, you would like to contact
Borland with comments or suggestions, we suggest the following procedures.

The best way is to log on to Borland’s forum on CompuServe: Type GO BOR
from the main CompuServe menu and follow the menus to section 4. Leave your
questions or comments here for the support staff to process.

If you prefer, write a letter describing your comments in detail and send it to
the Technical Support Department, Borland International, 4585 Scotts Valley
Drive, Scotts Valley, CA 95066, USA.

As a last resort, you can telephone our Technical Support department. If
you're calling with a problem, please have the following information handy
before you call:

* Product name and version number
* Computer make and model number
* Operating system and version number
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C H A P T E R 1

Setting Up

Before you actually begin using Turbo Pascal, you should make a backup copy of
your disks so that you can put your master disks in a safe place. This chapter tells
you how to do that. It also describes the files on your Turbo Pascal disks so that
you can see what files are provided and which you’ll need.

Before you go on, you should have some familiarity with the Mac. You should
know how to turn your Mac on and off, how to move the mouse around, how to
select commands from a menu, how to manipulate (move, resize, and close)
windows with the mouse, and how to select and launch applications. If you have
questions about using the Mac, please refer to your Macintosh owner’s manual.

Making Working Copies

Borland’s philosophy—selling software without copy protection—is based on
trust. As it says in the license statement at the beginning of this manual, you are
authorized to make working copies of the distribution disks. You can then put the
originals in a safe place.

Here’s how to copy your Turbo Pascal and Utilities & Sample Programs disks.

First, with the Macintosh off, put your Turbo Pascal disk in the internal disk
drive and turn the Mac on. The Mac boots up and displays a window with the
contents of your Turbo Pascal disk.



Second, insert a blank disk, or a disk that doesn’t contain anything you want to
save, in your external disk drive. (If you don’t have one, we'll tell you what to do
in a few paragraphs.) If you've inserted a new disk or one that’s been used with
some other computer system, the Mac asks if you want to initialize it. If it is in a
double-sided disk drive, you have the option of formatting it as single- or double-
sided; it's best to choose whichever corresponds to your internal disk drive.
Remember, initializing erases all existing files on the disk. When initialization is
done, you'll be asked to name the disk; give it something like “TP Mac.”

Third, point to the Turbo Pascal disk icon, press the mouse button, and hold it
down. Now drag that icon to the icon of your work disk. That disk’s icon should
now turn dark. Release the mouse button. You'll now get a dialog box that asks if
you really want to replace the contents of the disk in your external drive with the
contents of the disk in your internal drive. Point to OK and press the mouse

button. All the files on your Turbo Pascal master disk will be copied over to your
work disk.

Fourth, eject both disks: Click on the disk icon, then select Eject from the File
menu, or press (E)JE). Label your new working copy of Turbo Pascal, and store
your Turbo Pascal master disk somewhere safe. Turn your Mac off, place your
working disk into the internal disk drive, and turn the Mac back on. You now
have a working copy of Turbo Pascal.

Repeat with the Utilities & Sample Programs disk.

What If I Only Have One Disk Drive?

Prepare yourself for some disk swapping. Boot up with your Turbo Pascal master
disk, as described above, then eject it.

Insert your blank work disk. If necessary, initialize it as described above. You
should now have two disk icons on your desktop (Macintosh screen).

Drag the icon for the Turbo Pascal master disk onto the icon of your work disk.
You're asked to reinsert the Turbo Pascal master disk; do so. At the “Replace all
this?” prompt, click the OK button.

The actual copying now takes place. You'll be asked to swap disks from time to
time, so that your Mac can read from the master disk and write to the destination
disk. The actual number of swaps depends upon the size of your disk drive and
the amount of memory in your Mac.

Repeat this procedure with the Utilities & Sample Programs disk.
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What If I'm Using a Hard Disk?

Copy all the files and folders (except for the SYSTEM FOLDER) from your
Turbo Pascal master disks to any volume or subdirectory on your hard disk. Store
the masters.

Bypassing the Desktop

If your working copy of Turbo Pascal is a bootable disk (that is, if it is the disk you
boot from when you turn your Macintosh on), you can make Turbo Pascal your
startup application. This means that when you boot from your Turbo Pascal work
disk, instead of having to wait for the desktop to come up and then double-
clicking on the Turbo icon, you will automatically go into Turbo Pascal.

To do this, boot up using your Turbo Pascal work disk. Click once on the Turbo
icon, so that it becomes dark but doesn’t start executing. Go to the Special menu
and select Set Startup. A dialog box comes up, asking you to verify that you want
Turbo to be the startup application. Select the OK button.

From now on, when you boot up using that disk, you'll bypass the desktop and
go immediately into Turbo Pascal.

The Files on the Disks

Your Turbo Pascal master disks have quite a few files and folders (which contain
more files). Unlike the other Pascal programs, however, Turbo Pascal can run on
only the TURBO file. This simplicity makes Turbo Pascal easy to use and conser-
vative of your memory space. However, it doesn’t skimp on options.

Here’s a quick rundown of the files, with descriptions showing what each file
provides. The TURBO and SYSTEM FOLDER files are on the Turbo Pascal
disk; all other files are on the Utilities & Sample Programs disk.
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Table 1-1 Files on Your Distribution Disk

SYSTEM FOLDER
SYSTEM

FINDER

IMAGEWRITER

The Turbo Pascal compiler/editor. This file also contains
the Pascal run-time and Mac interface units. You
definitely need it.

A folder containing the system files:

The Macintosh operating system. This file also holds
system resources, such as fonts and desk accessories. Your
disk has only a limited number of these to conserve space.
Essential if you are going to boot up using your Turbo
Pascal work disk.

The Macintosh user interface program. This is what
brings up the desktop, allows you to select and run a
program, and so on. Also essential if you plan to boot
from your work disk.

The printer driver for the Imagewriter printer. You need
this if you're going to print anything, either from within
Turbo Pascal or within your own program.

UTILITIES

UNITMOVER

RMAKER

FONT/DA MOVER

MACSBUG

MACINTALK

ATALK/ABPACKAGE

SAMPLE PROGRAMS
MYDEMO.PAS

MYDEMO.R

This folder contains UNITMOVER, RMAKER,
FONT/DA MOVER, MACSBUG, MACINTALK, and
APPLETALK:

Utility for moving units (libraries) in and out of Turbo
Pascal. You don’t need it unless you write your own
units and store them in Turbo Pascal.

The Resource Maker. This converts resource source files
(.R) into resource data files (RSRC), which can then be
used by your programs. If you're writing Mac-style
programs, you'll need this file.

Utility for moving fonts and desk accessories in and out
of your SYSTEM file. You need it if you plan to write
desk accessories.

A debugger, that is, a program that helps you to track
down and correct errors in your program. This is for
more sophisticated users; after reading about it in
Chapter 14, you can decide whether to include it.

A resource file for speech synthesis. You'll need it to use
the MacinTalk unit in any of your programs.

A resource file for using the APPLETALK network.
You'll need it to use the APPLETALK unit in any of
your programs.

This folder contains sample programs, including:

A sample program that shows how to write Mac-style
programs. Brings up a window and its own menu bar;
allows you to run several different benchmarks
(graphics, 1/0, etc.); supports desk accessories.

A resource file for MYDEMO.PAS. You must run
RMAKER on it (producing MYDEMO.RSRC) before
you can compile and ran MYDEMO.PAS.
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Table 1-1 Files on Your Distribution Disks, continued

MYDA.PAS A sample desk accessory whose code illustrates all the
different events that you might need to handle in a desk
accessory.

MYDA.INC An include file for MYDA. PAS; it contains most of the
event-handling routines.

MYDA.R A resource file for MYDA.PAS. You must run RMAKER

on it (to produce MYDA.RSRC) before you can compile
MYDA.PAS.

What If I Don’'t Want to Use Turbo Pascal’s System Files?

Format a blank disk and copy onto it the system files you want to use. Boot up
using it. Put the Turbo Pascal master disk in your external drive. Copy to your
system disk all its files and folders, except for the one labeled SYSTEM
FOLDER.

Eject the Turbo Pascal master disk and put it somewhere safe.

What If I Don’t Want All the Turbo Pascal Files?

Make copies of the Turbo Pascal master disks, using one of the methods
described previously. Throw away (that is, move into the Trash icon) all the files
you want to get rid of.

Customizing Turbo Pascal

There are two sets of options that you can change to customize Turbo Pascal. The
first set can be examined and changed using the Option command in the Turbo
Pascal Edit menu. With it, you can set the tab width, toggle the auto-indent
mode, and tell Turbo Pascal whether or not you want it to bring up a new (“Unti-
tled”) window each time you go into Turbo Pascal. Chapter 3 has more details on
these options.

The second set of options is under the Options command in the Turbo Pascal
Compile menu. These options include toggling the auto-save mode, setting the
size of the symbol table, and specifying default directories (path names) for units
and include, resource, .REL, and output files. See Chapter 4 for more details.
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Where to Go from Here

By now, you should be set up to start using Turbo Pascal. Boot up your system (if
it isn’t on), double-click on the Turbo icon, and go on to Chapter 2. It explains
the different menu commands in Turbo Pascal.

You may want to quickly jump to the glossary and scan through the Turbo
Pascal icons shown there. That way, you'll be more familiar with the different
icons and the types of files they represent before you begin programming.
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C H A P T E R 2

Getting Started with Turbo Pascal

Now that you're all set up, let’s plunge right into writing your first Turbo Pascal
program. By the end of this chapter, you'll have written three small programs,
saved them, and learned a few basic programming skills. The last section offers a
game plan for proceeding through the rest of the manual, depending on your
programming experience.

Loading Turbo Pascal

If you're using a floppy-disk drive, first turn off your Macintosh. Put your Turbo
Pascal disk into the internal disk drive. Turn the Mac on. The Mac boots up and
displays a window with the contents of your Turbo Pascal disk. Near the top of
the window, you'll see an icon—Ilabeled “Turbo™—of a hand waving a checkered
flag. This is the Turbo Pascal compiler/editor.

To launch it, just point at it with the mouse and click twice, rapidly. The
desktop clears. A few moments later, a new menu bar appears, along with an
empty window labeled “Untitled” (see Figure 2-1). Youre now set up to write
your Turbo Pascal program.



Writing Your First Program

A blinking vertical bar is in the left-hand corner of the “Untitled” window. When
you enter a program, the text you type appears here. Now type in the following
program, pressing the key at the end of each line:
progran MyFirst;
begin

WriteLn(’Hello, universe!’);

Readln;
end.

Note the semicolons (;) at the end of the first, third, and fourth lines, as well as
the period (.) after the last line. If you make a mistake while typing, press the
key to erase what you have typed. (If you're familiar with Mac-style editors,
you can use the mouse to select and change text.)

Now go to the Compile menu and select the Run command (or press ()R]).
Turbo Pascal compiles and runs your program. If there is a syntax error (that is, a
Pascal language error), Turbo Pascal stops at that place in your program and tells
you what the error is. Acknowledge the error by clicking the mouse button or
pressing the key. Correct the error and then select the Run command again.

After all errors are fixed, Turbo Pascal completely compiles your program and
executes it. The menu bar and window disappear, a window labeled “MyFirst”
opens, and the message Hello, universe! appears in the upper left-hand corner
of the window.

Hello, universe!

Figure 2-1 The Compiled MYFIRST Program
The program then waits for you to press (this is what the ReadLn state-

ment does). When is pressed, the window disappears, and you're back in
Turbo Pascal.
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Saving Your First Program

Having written and compiled this masterpiece, you need to save it to disk, so
that you can modify it later. Go to the File menu and select the Save option (or
press (£)S)). A file-save dialog box comes up. Type in a name for your program,
say, “MYFIRST.PAS.” Turbo Pascal isn’t case-sensitive, so you can use uppercase
or lowercase when entering information. Press (&) and your program is saved to

disk.

If you exit Turbo Pascal (select Quit from the File menu), you'll see your
program file saved as a document icon with a checkered flag on it. If you want to
edit it some more, point the cursor to it and double-click.

If you want to run your program outside of Turbo Pascal, go to the Compile
menu and select the To Disk command (or press (£)X]). You don’t need to save
the file; just exit Turbo Pascal. You'll see your executable program, named
MYFIRST, saved under a standard Mac application icon (a hand writing on a
piece of paper). If you double-click on this icon, it will execute your Hello,
universe! program again, then return you to the Mac desktop when you press

=)

Stepping Up: Your Second Program

Now let’s look at a second program that does a bit more. It prompts you for a
location and a radius, then draws a black circle of that radius at the specified
location.

progran MySecond;

uses MemTypes,QuickDraw;

var
X,Y,Radius : Integer;
TRect : Rect;
begin
Write(’Enter X: ’);
ReadLn(X);
Write(’Enter Y: ’);
ReadLn(Y);

Write(’Enter radius: ‘);
ReadLn(Radius);
SetRect(TRect,X-Radius,Y-Radius,X+Radius,Y+Radius);
PaintOval(TRect);
ReadLn;

end.{ of program MySecond }
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The uses statement asks Turbo Pascal to let you use two units (program
libraries), MemTypes and QuickDraw. This gives you access to the graphics data
types and routines (Rect, SetRect, and so on).

You've declared four variables in this program: X, Y, Radius, and TRect. X and
Y are integers (numbers); they store the values you type in for the location of the
center of the circle. Likewise, Radius is an integer that holds the radius (distance
from the center to the edge) of the circle. TRect is a variable of type Rect, a
special Macintosh data type that holds a description of a rectangle (top, left,
bottom, and right values).

The first six statements of the program consist of three Write statements and
three ReadLn statements. Each Write statement writes the string inside of it out
to the screen; each ReadLn statement waits for you to type a value and press
(&), after which it stores the value in the enclosed variable.

The next two statements call QuickDraw routines. SetRect gives the variable
TRect the boundaries indicated (X-Radius and so on). The resulting rectangle
determines the size of the circle you want to draw. PaintOval takes the informa-
tion in TRect and uses it to paint a black circle just within the rectangle’s bound-
aries. The last statement, ReadLn, causes the program to wait for you to press
before it exits the program and returns to Turbo Pascal (or, if you've com-
piled to disk, to the Mac desktop).

Programming Pizazz: Your Third Program

You've now dabbled in graphics, so let’s explore a more complex program. It
offers more variety and interesting graphics.

program MyThird;

uses MemTypes,QuickDraw;

const

Start = §0;

Finish = 250;

Step = 2;
var

X1,X2,Y1,Y2 : Integer;
begin

Yl := Start;

Y2 := Finish;

X1 := Start;

while X1 <= Finish do
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begin
X2 := (Start+Finish) - X1;
MoveTo(X1,Y1);
LineTo(X2,12);
X1 := X1 + Step
end;
X1 := Start;
X2 := Finish;
Y1 := Start;
while Y1 <= Finish do
begin
Y2 := (Start+Finish) - Yi;
MoveTo(X1,Yl);
LineTo(X2,12);
Y1 := Y1 + Step
end;
ReadLn;
end.{ of program MyThird }

This program produces a square with a black center and some interesting
patterns (known as Moire patterns) along the edges. The section labeled const
defines three numeric constants (Start, Finish, and Step) that affect the size,
location, and appearance of the square. By changing their values, you can change
how the square looks.

WARNING: Don'’t set Step to anything less than 1; if you do, the program will
get stuck in what is known as an infinite loop. You won’t be able to exit except by
pressing the interrupt switch or by turning your Mac off.

The variables X1, Y1, X2, and Y2 hold the values of locations along opposite
sides of the square. The square itself is drawn by drawing a straight line from
(X1,Y1) to (X2,Y2). The coordinates are then changed, and the next line drawn.
The coordinates always start out in opposite corners: The very first line drawn
goes from (50,50) to (250,250).

The program itself consists primarily of two loops. The first loop, as we men-
tioned, starts by drawing a line from (50,50) to (250,250). It then moves the X
(horizontal) coordinates by two, so that the next line goes from (52,50) to
(248,250). This continues until it finally draws a line from (250,50) to (50,250).

The program then goes into its second loop, which pursues a similar course,
changing the Y (vertical) coordinates by two each time. The routines MoveTo and
LineTo are from the QuickDraw unit. MoveTo moves to the indicated spot on the
screen without drawing anything, while LineTo draws a line from the current
location to the one given.

The final ReadLn statement causes the program to wait for you to press (&)
before exiting.
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Where to Go from Here

You've now gotten your feet wet and have written three quick programs using
Turbo Pascal for the Macintosh. How do you proceed from here?

If you're a complete novice without any Mac or programming experience, read
the rest of Part I very carefully, following all the examples shown. Make sure you
understand each chapter before moving on to the next. If you're an experienced
Mac user but you haven’t done any programming, a quick once-through is all you
need on Chapter 3. The rest of the chapters will require careful attention,
though.

If you're proficient on the Mac and have done a fair amount of programming,
but not on the Mac, read Chapters 4 and 5 to familiarize yourself with Turbo
Pascal. Then pay special attention to Chapters 6, 9, and 10.

If you've done a lot of Mac programming but not in Pascal, then concentrate on
Chapters 4, 5, 7, and 8. Chapters 6, 9, and 10 should then help you to see the
differences in programming with Turbo Pascal and whatever language you were
using.

If you've already used Pascal on the Mac, Chapters 4 and 7 will require special
attention, while you can probably skim the rest.

Finally, there are a few other books you might consider reading after you've
finished this manual. If you are planning to do much Mac-style programming
with graphics, windows, menus, and so on, we recommend Inside Macintosh
(Addison-Wesley, 1986). This consists of four softbound volumes (or hardbound
and softbound set). It is the reference work for information on how to use the
Mac Toolbox and operating system routines. If youre not familiar with Pascal,
you’ll probably want to pick up a good tutorial on the language. Many such books
are available, including several that are specific to the Macintosh.

We've tried to make this the best user’s guide and reference manual possible.
After working through it, you should feel at home with Turbo Pascal. Good luck,
and happy programming!
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C H A P T E R 3

Using the Editor

In this chapter, you'll learn the basic editing features of Turbo Pascal—how to
enter a program, move and format text, undo commands, and save files.

A Quick Review of Clicking

Remember, you should be familiar with the Macintosh—be able to click on
icons, open and close folders and disks, and select commands from menus—
before you go on. If you aren’t, read the user’s guide that came with your com-
puter and familiarize yourself with those operations first. Let’s quickly review
the technique of clicking, however.

Any movement of the mouse is echoed by the arrow-shaped pointer on the
screen. When you place the pointer on, say, an icon and quickly press-and-
release the mouse button, that’s called clicking. It selects and highlights what-
ever you just clicked on. You can then go to the menu and choose the command
you want performed on the highlighted item.

As a shortcut, you can double-click on the item to select and open it—and skip
the menu-selection steps.

Shift-clicking is another option. If you hold (&) down and move the mouse to
a second location, everything between the original mouse location and its cur-
rent location is selected and highlighted.



Opening Turbo Pascal

Getting into Turbo Pascal is easy. Look for the Turbo Pascal icon, a hand waving a
checkered flag, on your disk. Move the cursor to it and click on it twice, rapidly.
After a few seconds, the Macintosh desktop is replaced by the Turbo Pascal menu
bar, and a window (labeled “Untitled”) appears.

You can also get into Turbo Pascal by clicking on its icon once, going to the File
menu, and selecting the Open command (or press (¥)2]).

Close the “Untitled” file by clicking on the Close box, then select Quit from the
File menu. You're back in the Mac desktop. Double-click on the MYFIRST.PAS
file you created in the last chapter. A new window appears, called “MYFIRST.PAS,
with the program you entered previously.

You can identify programs written with the Turbo Pascal editor; they look like
a sheet of paper with the top right corner bent down and a checkered rectangle
centered on the sheet. When you open one of these files, you start up Turbo
Pascal, which opens a window with that program in it.

Return to the Mac desktop. This time, double-click on the MYFIRST icon (a
hand writing on a sheet). Your compiled program appears. Exit it by pressing
(«@). The Mac desktop reappears.

Editing a File

An editor is a program that allows you to edit text, that is, to enter, delete, or
change what you've typed in. Turbo Pascal has a built-in editor that is available at
all times. With it, you can write new programs and modify existing ones. You can
add, delete, and change code. The Edit menu shows some of these features.
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Figure 3-1 The Edit Menu

Let’s start by typing in a new program.

Entering a New Program

Double-click the Turbo Pascal icon. An empty window (called “Untitled”) covers
most the screen. If someone has used this program previously and the window
has text in it, close the window by clicking on the Close box in the upper left
corner of the window. A blank screen with the desktop and Turbo Pascal menu
bar remains; go to the File menu and select the New command (or press EJXJ).
Now you should have an empty window named “Untitled.”

There are two different cursors on the screen. One is a vertical blinking bar in
the upper left corner of the window. If you type the following line

program Quickie;

this cursor moves to the right as you type. It indicates where the next letter you
type will appear. Press [€2), and the cursor moves to the start of the next line.
Now type the following two lines, pressing after each one:
var
begin

The bar cursor should now be at the start of the line underneath the word
begin.

The second cursor on the screen is larger and is shaped like an I-beam. It is
“connected” to the mouse; that is, it moves on screen as you move the mouse on
your desk top. When you move this cursor outside the window, it turns into an
arrow; move it back into the window, and it becomes an I-beam again. Now,
move it right after the word var, then click once. The bar cursor jumps from the
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beginning to the fourth line to where the I-beam cursor was when you clicked
the mouse button. Press (&), indent two spaces, and type

A,B,C : Integer;
Your window should now have the following text:

program Quickie;
var

1,B,C : Integer;
begin

The blinking bar cursor should be just after the semicolon (;) following the
word Integer. Now move the I-beam cursor to the line below the word begin and
click once. The bar cursor should jump down there. Add two space indents, type
the following line, then press [€2):

WriteLn(‘Hello, world’);

If you correctly typed two spaces before starting WriteLn, the bar cursor
should be indented two spaces in: It lines up with the word WriteLn. This is
known as auto-indenting, and it helps you follow your programming conven-
tions. (You can turn it off, if you like.)

Now, press twice (it’s located above (€2)). The bar cursor should be at the
left margin again. Type end. (with a period) and press (€). Your entire program
should now look like this:

& File Edit Search Format Font Compile Transfer
EC] = =

program Quickie;
var

A,B,C : Integer;
begin

Writeln('Hello, world");
end.

Figure 3-2 The Quickie Procedure Window
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Changing a Program

There are several ways to change or modify a program. The simplest way is to
add new text. Move the I-beam cursor to just after the semicolon following
(Bello, world) and click once. The bar cursor moves there. Press (€2) and type:

WriteLn(‘What’s your sign?’);

You've added a new line to your program. Because of the auto-indenting, this
statement lines up with the_one above it.

The next simplest change is to delete text. Press several times. You'll see
that you're erasing what you’ve just typed. If you keep pressing it, or if you hold
it down, it continues to erase the characters to its left. When you get to the start
of the line, it jumps back up to the end of the previous line, and all the text below
(which right now is just the line end.) moves up. If you're still holding down,
you'll find that your entire program will soon be erased, character by character.
Stop, and retype all you've erased.

Suppose you wanted to change the string Hello, world to Hi, world. Use the
following steps:

1. Move the I-beam cursor until it'’s between the O and the comma in
Hello, world. Click the mouse once to move the bar cursor there.

2. Press four times to delete ELLO.
3. Type I (comma).

Now, following the steps above, change the word WORLD to your own first
name.

The key .on the numeric keypad (or if you don’t have a numeric
keypad) is also used to delete text. When the cursor is in the middle of a line,
pressing deletes all characters to the left of the cursor until the beginning of
the line. This is handy in connection with the auto-indent feature when you want
to un-indent a line, that is, remove blanks that were automatically inserted by
pressing (&2). If you press when the cursor is at the beginning of a line, the
line above is deleted.

Selecting, Cutting, and Pasting Text

A powerful feature of the Turbo Pascal editor is that it lets you cut portions of text
and paste them elsewhere. You can use the I-beam cursor and the mouse to
select portions of text—like setting aside selected pages of a document—while
you decide what to do with them.
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Let’s say that you want to delete the variable declarations in your program.
Move the I-beam cursor in front of the word var. Now, press the mouse button
and hold it down. While holding the mouse button down, slowly move the
I-beam cursor down the screen. Each line that it passes turns black with the text
reversing (called inverse or reverse video). The text is what you are selecting.
Now, with the mouse button still pressed, move the I-beam cursor until it’s right
in front of the word begin. The two lines above it,

var
A,B,C : Integer;

should be in reverse video. Release the mouse button. The lines remain black
because they are selected.

You now have several options. To do nothing, move the I-beam cursor any-
where and click once. The text will be de-selected; that is, it will return to
normal. You can do this anytime you accidentally select text that you don’t want
selected. Try this out, then go back and re-select those two lines.

The next option is to delete the selected text. You can press (€], and the text
will vanish. You can restore it by selecting Undo from the Edit menu, which is
explained in a later section. The same thing happens if you go to the Edit menu
and select the Clear command. You can also select the Cut command from the
Edit menu (or press (£)X])). That deletes the text but saves it in the Clipboard, a
holding area for text that’s been cut (or will be copied). Practice using these
deletion options, then reenter the two lines. Select them again.

The third option is to copy the selected text. Go to the Edit menu and select
the Copy command (or press (£)CJ). The selected text looks the same on the
screen, but acopy of it has just been placed in the Clipboard.

Fourth, you can replace the selected text. Whatever you start typing replaces
the selected text. As soon as you press the first key, the entire selected text
disappears and your new text replaces it as you type.

If you have cut or copied text, so that you have text in the Clipboard, you can
select the Paste command from the Edit menu (or press (8)Y)). The text in the
Clipboard automatically replaces the selected text.

If you have cut or copied text into the Clipboard, you can insert or paste it
anywhere in your program. Select a line of text, then cut or copy it using the
Edit menu. Now move the I-beam cursor to where you want to insert the text,
and click the button once. The blinking bar cursor appears there. Go to the Edit
menu and select the Paste command (or press (2JY]). The selected text is now
pasted where the cursor is. A copy of that text is still in the Clipboard; you can
move somewhere else and paste it in again.
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Try out these commands, until you're comfortable with them. Then you can do
the following exercises:

1. Change the name of the program to Mortiner by selecting the word
Quickie and then typing Hortimer. Practice selecting individual words
and letters on a given line.

2. Delete the var and 4,8, C : Integer; lines using three different means.
Retype or paste them back in each time.

3. Insert the statement KriteLn(’Ais3.’); between the first and second
WriteLn statements. (Don’t forget the semicolon at the end.)

The Undo Command

During the exercise above, you may have accidentally deleted or changed some-
thing. You probably went in and retyped the altered text. The Turbo Pascal
editor helps protect you from your own mistakes with the Undo command in the
Edit menu.

Try the following exercise. Move the I-beam cursor to the start of the program,
hold the mouse button down, and move the I-beam cursor to the end of the
program. The entire program should now be selected. Now press (€=). Presto!
Your entire program has just disappeared! Don’t panic. Instead, select the Undo
command in the Edit menu (or press (8)Z)). Your entire program resurfaces.

You can only Undo the last action you did. Select var, for example, and press
(€=); var disappears. Now move the cursor to the end of the program. If you click
on the Edit menu, Undo appears blurred; that is, it cannot be selected. Even if
you move the cursor back to the empty line and select Edit, Undo will still be
blurred. You have to retype var; the selection can’t be undone.

Spend some time experimenting with the Undo command, seeing what you
can (and can’t) undo. This is a really valuable command, so take the time to learn
it well.

Formatting Text

Many Pascal programmers format their programs with indentation, aligning
begin and end keywords, nested statements, and so on. Often a level of nesting
will change: A set of statements will be moved out of an if..then statement, or
into a for loop. To maintain the correct nesting format, the programmer then has
to shift all the code—line by line—left or right, according to the change.
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With the Turbo Pascal editor, such formatting changes are easy. Just select the
text to be shifted, using the click-and-drag technique: Put the pointer at the
beginning of the selected text, hold the button down, and move to the end of the
text. Release the button. Then press to shift left, or to shift right.
Each press of the command sequence shifts the entire selected block of text one
character left or right. You can also do this by selecting the Shift Left or Shift
Right commands in the Edit menu.

Finding a Lost Bar Cursor

The location of the bar cursor—the short, blinking one that indicates where the
next character you type will appear—is quite different from the location of the I-
beam cursor, the one reflecting mouse movements. In a large file, it is possible to
lose the bar cursor, because of scrolling to (that is, viewing) a different part of the
program from where the bar cursor is. Two commands in the Turbo Pascal editor
help you to deal with that.

First, if you press (or (®)«2)), the text display will be scrolled upwards or
downwards until the first or last line in the window is the line with the bar
cursor. No text will be changed. Second, you can use the Home Cursor com-
mand in the Search menu (or press (Z)H]). This moves the bar cursor to the very
top of the file and adjusts the display to show it.

Search and Replace

The Turbo Pascal editor lets you search for a particular string (that is, a delimited
group of characters). It also lets you change one string for another.

To find a given string, such as a variable or procedure name, select the Find
command in the Search menu (or press (2)EJ)). A dialog box comes up that asks
you to specify what you want found. There are two checkboxes, Words Only and
Case Sensitive. The first means that it won’t recognize the string if it's embed-
ded in a larger string. For example, if you are looking for myGlobals and selected
this option, then it wouldn’t pick out the string in myGlobalsH. Second, specify-
ing Case Sensitive means that uppercase and lowercase letters are not consid-
ered to be equivalent. If you are looking for myGlobals, then MyGlobals doesn’t
match.

Having typed in your string, start the search by pressing or by selecting
the OK button in the dialog box. The editor starts searching from the current
position of the bar cursor until it either finds the string requested or hits the end
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of the file. If it finds the string, that section of your program appears on the
screen, with the specified string highlighted. If it doesn’t find the string, it beeps
at you, and the screen stays the same.

Having found the first instance, you can find the next appearance of the string
by selecting the Find Next command from the Search menu, or by pressing
(&E)2). You can also select Change to replace one string with another.

You can use key equivalents in the Search and Replace dialog box; that is, you
can type (] for Yes, (] for No, (2] for All, and (€] for Cancel.

Saving Your Text

There are several ways of saving the text you have entered in a window:

* Select the Save command in the File menu (or press () §)). If your window
already has a title, the text is saved on the disk, overwriting the old version of
the file. If your window is untitled, the Save-file dialog box comes up. Select
the proper drive and directory, type in a name for your text, and click the Save
button (or press (€2)). After saving the text, your window’s title is changed to
the file name you just entered. When naming your files, it’s advisable to use
extensions, for instance . PAS for Pascal programs and .R for RMAKER source
files. This enables you to use the same name for different files relating to the
same application, such as MYPROG.PAS and MYPROG.R. Furthermore,
it makes it easy to determine the type of a textfile without having to actually
read it.

* Select the Save As command in the File menu. This corresponds to the Save
command, except that it always brings up the Save-file dialog box, thus allow-
ing you to save the text under a new name.

* Select the Close command in the File menu (or press (%]). This saves the text
(corresponding to the Save command) and removes its window from the desk-
top. The Close command only saves the text if it has been modified since it was
last saved, or since the window was opened.

¢ Click on the window’s Close box. This corresponds to selecting the Close com-
mand in the File menu.

* Select the Quit command in the File menu. This closes all windows and
returns to the Macintosh desktop (the FINDER).

Now that you know how to edit your program, let’s move on to Chapter 4.
You'll learn how to tell the computer to carry out your program.
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€ H A P i E R 4

Using the Compiler

You now know how to create a program and save it to disk. Now, let’s look at how
to tell the computer to carry out the instructions you've typed in. This is done
with the commands in the Compile menu.
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Figure 4-1 The Compile Menu

We'll briefly describe the Run command, then examine all the other com-
mands in the Compile menu: Run, To Memory, To Disk, Check Syntax, Find
Error, Get Info, and Options. We'll also explain how Turbo Pascal handles syntax
and run-time (system) errors.
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An Overview of the Run Command

Say you've typed in a program using the Turbo Pascal editor. To make it run, pull
down the Compile menu (click on Compile in the menu bar) and select the first
option, Run. You can avoid using the mouse by pressing (#)&]). Turbo Pascal
then compiles your program, that is, changes it from Pascal (which you can read)
to 68000 machine code for the microprocessor (which the Macintosh can exe-
cute). You don’t see the 68000 machine code; it’s stored off in memory some-
where.

While the program is compiling, the cursor is changed to a racing flag and a
small box (or window) appears at the top of the screen, saying Conpiling: <file
nane>. The box includes a button labeled Cancel. Use it to stop the compiler for
any reason—for example, if you've suddenly remembered a change you forgot to
make to your program. Just move the cursor over the word Cancel and click the
mouse button. Turbo Pascal then returns you to the editor.

Should an error occur during compilation, Turbo Pascal stops compiling and
returns to the editor, with the cursor at the error location. A dialog box tells you
what the error was. Click on the error box, correct the problem, and select Run
again.

Once the translation from Pascal to machine code is complete, Turbo Pascal
tells the Mac to execute the code it has generated and your program runs. Your
program takes control of the Mac and completely replaces the Turbo Pascal
screen and menu bar.

If a run-time error crops up—that is, an error occurs while your program is
executing—you’ll get the standard Mac system error box. This is a box with a
bomb icon in it and two buttons: Restart and Resume. If you select the Resume
button, you return to the Turbo Pascal editor. When possible, the cursor is at the
section of code where the error took place; for some errors (such as pressing the
Interrupt switch on the side of the Mac), there is no way of determining what
part of the program was executing when the error occurred, so the cursor is
placed at the beginning of the text. Restart reboots your computer.

NOTE: You should not use the Interrupt switch on the Mac Plus unless the
debugging program MACSBUG is loaded. Without MACSBUG, the program
merely goes into a simple debugger built into the Mac; a bomb box showing you
the error doesn’t appear.

When you press Resume, a box pops up, telling you what the error was (input/
output, division by zero, and so on). After you figure out how to fix the program
bug, you can recompile and run the program again.

When your program has finished executing, the Macintosh returns control to
Turbo Pascal, and you're back where you started. You can now make changes to
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improve or cause your program to do something different. If you select the Run
command at this point without changing your program, Turbo Pascal immedi-
ately executes it, without recompiling.

The Turbo Pascal Compiler

You can now run your programs. As you have seen, Turbo Pascal is very forgiving
of errors and does its best to help you track down and fix them. Because of Turbo
Pascal’s accommodating structure and high speed of compilation, the cycle of
entering, testing, and correcting your program wastes little time. Let’s look at
different aspects of that cycle in more detail.

So, What’s a Compiler Anyway?

The Macintosh, like most microcomputers, has a central processing unit (CPU)
that does most of the work. On the Mac, the CPU is a single chip: the 68000, a
microprocessor designed by Motorola. The 68000 has a set of binary-coded
instructions that it can execute. By giving the 68000 the right sets of instruc-
tions, you can make it draw objects on the screen, perform math, move text and
data around—in short, do all the things that you want it to do. These instructions
are known collectively as machine code.

Since machine code consists of pure binary information, it’s neither easy to
write nor easy to read. You can use a program known as an assembler to write
machine-level instructions in a form that you can read. This is known as pro-
gramming in assembly language. However, you still have to understand just how
the 68000 microprocessor works. You'll also find that to perform simple opera-
tions—such as printing out a number—often requires a large number of instruc-
tions.

If you don’t want to deal with machine code or assembly language, you use a
high-level language such as Pascal. You can easily read and write programs in
Pascal, because it is designed for humans, not for computers. However, the Mac
understands only machine code. The Turbo Pascal compiler translates (or com-
piles) your Pascal program into instructions that the computer can understand.
The compiler is just another program that moves data around; in this case, it
reads in the text of your program and writes out the corresponding machine
code.
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What Gets Compiled?

You can edit up to eight different Turbo Pascal programs at the same time, each
with its own window. If you have several windows open, which one is affected
when you select a command from the Compile menu? As with the editing com-
mands, it's the program in the currently active window, that is, the window
whose title bar has horizontal lines and a close box in it. All the other (inactive)
windows have nothing in the title bar except for the window’s title (either the file
name or “Untitled”).

As with the editor, to make a window active, you move the cursor into it and
click the mouse once. If the windows overlap, this brings the one you just
selected to the front, so that you can see the entire window.

You can also use the Window command in the Search menu. Selecting the
Window command brings the first window you opened to the front, and so on
sequentially.

Where's the Code?

When you use the Run command, Turbo Pascal saves the resulting machine code
in memory (RAM). This has several advantages. First, the compiler runs much
faster, since it takes less time to write the machine code out to RAM than out to a
floppy or hard disk. Second, since your program is already loaded into RAM,
Turbo Pascal just tells the Macintosh to execute your code. Third, the Mac more
easily returns to Turbo Pascal once your program stops executing, since Turbo
Pascal also stays in RAM the whole time. Fourth, Turbo Pascal allows you to
open several program windows and compile them to RAM. You can then execute
each of them without recompiling.

If compiling to RAM is so wonderful, why wouldn’t you want to do it every
time? Two reasons. First, you would be able to run your programs only from
Turbo Pascal. If you compile only to RAM, the resulting machine code is never
saved on the disk, so you have no way of executing your program from the
Finder. You also have no way of copying your program.

Though less likely, the second problem is memory: You might not have
enough. It could happen if you're using a “thin” (128K) Mac, if your program is
very large, if your program uses a lot of memory for dynamic data allocation, or if
you have opened several windows and have compiled each of them.

It’s easy to produce a code file (application) that you can run from outside
Turbo Pascal: Select the To Disk option in the Compile menu (or press E)X)).
This produces a code file that you can run from the Mac desktop by double-
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clicking its icon, or from within Turbo Pascal by using the Transfer command in
the File menu.

The file produced by a (Compile) To Disk command has the name used in your
program header. In other words, if your program has the header

program MyOwnProgram;

then the resulting code file is named MYOWNPROGRAM. However, you can
specify a different file name (and a particular volume or subdirectory) by using
the $O compiler option, such as

{$0 Turbo:code:MyProg}

Appendix C, “Compiler Directives,” has more details. In either case, the icon
used is the standard Mac application icon of a hand writing on a piece of paper.
You can create your own icon using a resource file; see Chapter 9 for further
details.

Unlike the Run command, the To Disk command does not automatically exe-
cute your program once the compilation is done. You can execute it using the
Transfer command in the File menu or by leaving Turbo Pascal and clicking on
the icon. Or you can recompile it to RAM with the Run command, which then
automatically executes it.

You may want to compile a program to RAM without running it. Perhaps you
have several programs open, and you want to compile each of them to RAM
before running them. In this case, select the To Memory command in the Com-
pile menu (or press (#)M)). It works just like the Run command with two ex-
ceptions. First, it does not execute the program once compilation is done; -
instead, it leaves you in Turbo Pascal. Second, it always compiles the program,
while the Run command recompiles only if you've modified the program since
the last compilation. If you use the To Memory command, and select Run with-
out making any changes to the program, the Run command won’t recompile your
program.

Syntax Errors

Just like English, Pascal has rules of grammar that you must follow. However,
Pascal’s rules are fairly strict, much more so than those of English. You can use
poor grammar in speaking and still be understood,; if you use poor “grammar” in
your Pascal program, however, the compiler won’t understand what you want.
The result is a syntax error, which happens when you don’t use the appropriate
words or symbols in a statement, or when you organize them incorrectly.

When the compiler detects a syntax error, Turbo Pascal stops the translation
and goes back to the editor. Once there, it moves the cursor to the spot in your
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program where the error occurred. It then displays a box across the top of the
screen, explaining (in brief terms) what the error was. Press to make the box
go away, or move the cursor (via the mouse) into the box and click the mouse
button.

What syntax errors are you likely to get? Probably the most common error
novice Pascal programmers make is Unknown identifier. Pascal requires that you
declare all variables, data types, constants, and subroutines—in short, all identi-
fiers—before using them. If you refer to an identifier that you haven’t declared,
or if you misspell it, you'll get this error. Other common errors are ‘;’ expected,
which means that you need to put a semicolon at the end of the previous state-
ment, and ‘:=’ expected, which means that you need to use the assignment
operator (:=) instead of the equals sign (=). Appendix B, “Error Messages and
Codes,” lists all the compiler syntax errors.

You can check for syntax errors without compiling the program by using the
Check Syntax command in the Compile menu (or pressing (#)X)). Turbo Pascal
then checks your program’s syntax, but doesn’t produce any machine code. This
is faster than compiling to disk, so it's a handy way to clean up syntax errors
before producing a code file. On the other hand, it isn’t significantly faster than
compiling to memory, so consider using the Run or To Memory commands
(unless you want to avoid compiling to memory for the reasons previously dis-
cussed).

Run-time (System) Errors

In programming, sometimes just following the rules governing correct syntax
isn’t enough. For example, suppose you write a simple program that prompts
you for two integer values, adds them together, then prints out the result. The
entire program might look something like this:
progran AddNunms;
var

A,B,C : Integer;
begin

Write(’Enter two integer values: ‘);

ReadLn(A,B);

C := 1 + B;

WriteLn(‘The sum is /,C);
end.

In response to the prompt Enter two integer values:, say you type in real
numbers (that is, numbers with decimal points), integer values that are too
large, or even character strings instead of numbers. What happens? The Mac
system error window appears, with the bomb icon and an error ID code in it.
You are given two options, each presented as a button: Restart and Resume.
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The Restart button, which you can always use, reboots your Macintosh, just as
if you had turned your Mac off and on or you had pressed the Reset switch on the
side of your Mac (assuming you have one installed; it’s the one closest to the
front). This button is best used only when you have no other option.

If you are running from within Turbo Pascal, you can select the Resume button
instead. It puts you back into Turbo Pascal, with your windows (and files) still
intact. This means that even if you didn’t have the Auto Save option selected, the
program file you've been editing for the last hour isn’t gone. It’s still there—
unless, of course, your program went totally amok and wrote over large portions
of memory (in which case you wouldn’t have been able to get back to Turbo
Pascal anyway).

For errors within a Turbo Pascal program, such as division by zero, range
overflow, and I/O error, the cursor is moved to where the error took place, and a
window with the bomb icon and a description of the error type appears. You
must acknowledge the error by moving the cursor to the message window and
clicking the mouse, or by pressing (€). The window goes away, and you can
figure out what changes (if any) to make to your program. If, after moving around
in your program, you want to find the error again, select the Find Error com-
mand from the Compile menu (or press (E)E)). Turbo Pascal quickly recompiles
your program (without producing code) and places the cursor where the error
took place, with the bomb box again explaining the error.

Should the error occur within an include file (the next chapter has more infor-
mation on include files), Turbo Pascal automatically opens a window for that file,
reads it in, and moves the cursor to the error’s location. If a window for that file is
already open, that window is brought to the front, and the error located.

There’s a way to go out on a limb and deliberately trigger a Mac system error:
Press the Interrupt switch on the side of the Mac (assuming you have one
installed; it’s the one closest to the back). You might need to do this if, for exam-
ple, your program is stuck in some section of code, such as an infinite loop. You
won’t be able to use the Find Error routine to locate where your program was
when you interrupted it, but you can get back to Turbo Pascal without losing
your program text and the cursor may be positioned at the point in the program
where the execution was.
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The Get Info Command

The Get Info command, which you can also invoke by pressing (£J 1], brings up
a window that tells you how big the text of your Pascal program is, both in
bytes and in lines. If you haven’t compiled your program yet, or if you've made
changes since your last compilation, it'll tell you that the program is Not
compiled. Otherwise, it gives you the size of the code (in bytes) as well as the
number of bytes that will be allocated for data when the program is run. Finally,
it tells you how large the heap is and how much of that space is available. (The
heap is where dynamic variables are created using the standard procedures New
and Dispose.) Click on the OK button to make it go away, or press (&)

The Options Command

The last item in the Compile menu is the Options command, which doesn’t have
a keyboard equivalent. It allows you to set up some default information for use
by the Turbo Pascal compiler. First, you can decide how much space (in kilo-
bytes) to allocate for the symbol table. The default is 32K, which is the maximum
size. If you're running on a 128K Mac, you might want to make it smaller to get
some memory back for compilation.

Second, you can set Auto Save to take effect when Run is selected. Auto Save
automatically saves all edited windows to the disk when the Run command is
selected from the Compile menu. Turbo Pascal keeps track of whether you've
made changes in a given window since the last time you saved it to disk. When
you select Run, Turbo Pascal first performs the Save command for all windows
that have been modified.

Finally, you can set the default directories for all the compiler directives that
reference files: $U (units), $I (include files), $R (resource file), $L (assembly
language .REL files), and $O (output file). These compiler directives are dis-
cussed in further detail in Appendix C. Having made the changes you want,
select either the OK button, which allows you to use these options, or the Cancel
button, which ignores whatever changes you've made to the options. In either
case, you're returned to the Turbo Pascal editing window.

If you want to make these options your standard settings, select the Save
Defaults command in the File menu.

The ability to specify directories is very useful if you're running under Apple’s
Hierarchical File System (HFS) and want to keep these files in different sub-
directories. If you don’t specify a directory for a given option, the current direc-
tory is assumed. However, if the compiler option itself contains the directory
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(such as {$I Turbo:otherstuff:linked.lib}), then the default directory (blank or not)
is ignored completely.

Now that you're acquainted with the commands in the Compile menu com-
pletely, you're ready to move on to the next chapter. In it, you'll learn how to
create a “textbook” Pascal program.
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C H A P T E R 5

Writing Textbook Pascal Programs

This chapter gives you the information you need to take standard Pascal pro-
grams out of textbooks and get them to run under Turbo Pascal. We'll review
briefly how to create and save a program, then go into the Pascal run-time envi-
ronment. We'll also cover compiler directives, input/output error checking, and
range checking.

Turbo Pascal makes it easy for you to create a standard or “textbook” Pascal
program on the Macintosh. No special knowledge is required; you just type in
your program, compile it, and run. Turbo Pascal sets up a window for you and
treats it like a plain CRT monitor. You can write to the screen, prompt for (and
receive) input, move the cursor around, have the screen automatically scroll, and
so on.

In other words, you don’t have to know anything at all about the innards of a
Macintosh to start writing Pascal programs on it. Most routines you find in text-
books run just fine under Turbo Pascal, with a few exceptions that we'll discuss
later in this chapter.

To start with, let’s review how to get a new program typed in and running.
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Creating a Program: A Quick Review

To write and run a program, you need only follow the steps you've learned so far.
Here’s the procedure:

L

Move the mouse to the Turbo icon and double-click on it. Turbo Pascal
brings up its menu bar and presents you with a blank program window
labeled “Untitled”. If this window doesn’t appear (which could happen
if you've disabled the Startup Window option using the Options com-
mand in the Edit menu), create a new window with the New command
in the File menu (or press (E)JN)).

Type your program in, using the keyboard, mouse, and menu com-
mands discussed back in Chapter 3. Save it out to disk using the Save
command in the File menu. Select the Options command in the Com-
pile menu, and enable the Auto Save option if it’s not already enabled.

Select the Run command from the Compile menu (or press EJ&)). If
an error is found, Turbo Pascal returns you to the editor. Correct the
error and select the Run command again.

Once you've corrected all syntax errors, your program will execute. If
you have run-time errors, the Mac System Error box will appear. If that
happens, click on the Resume button. You'll find yourself back in the
Turbo Pascal editor, with the cursor placed where the error occurred, if
it can be located. Correct the error, and select Run again. If you totally
crash the system somehow, reboot the Mac and double-click on your
program document icon. You'll be returned to Turbo Pascal, and you
can edit your program. (This is why you set the Auto Save command:
So that your source code is automatically saved to disk before each Run
command.)

Once you've corrected all your run-time errors, save your program to
disk again (select the Save command from the File menu, or press
(#)S)). Now select the To Disk command from the Compile menu (or
press (2)X)). When that’s done, exit Turbo Pascal by selecting Quit
from the File menu (or press (£}(Q)).

Your program is now an executable file, appearing as the standard Mac
application icon (a hand writing on a blank piece of paper). You can run
it any time by double-clicking on that icon.

Let’s look at some sample programs based on Standard Pascal.
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Sample Pascal Programs

Consider the following program:
progran Product;

var
A,B : Integer;
[o : Real;
begin

Write(’Enter two integer values: ‘);
ReadLn(A,B);
C := 1k + B;
WriteLn(’The product is ’,C:8:2);
ReadLn;

end.

This program runs as written. A window (labeled “Ratio”) is created. The
prompt Enter two nunbers: is written in the upper left corner of the window, and
the blinking cursor sits a few spaces past the end of the prompt. The program
then waits for you to type in two integer values. You may separate them with a
blank or a carriage return, and you can use to delete and retype what you've
entered.

After you type the second value, press (€). The program calculates A*B (con-
verting to real) and assigns the resulting value to C. It then writes out the mes-
sage The product is, followed by C’s value in a field eight characters wide, with
two digits appearing after the decimal point.

The program then waits for you to press (&), at which point it closes the
window and returns either to Turbo Pascal (if executed with the Run command)
or the Finder (if executed from the desktop or by using the Transfer option in the
File menu).

Here’s a second, even quicker example:

progranm Table;

var
I : Integer;

begin
for I := 1 to 100 do

WriteLn(I:3,’ ‘,(I*I):k);

Readln;

end.

When you run this program, you'll notice a few things. First, the window is
now labeled “Table” to match the name in the program header. Second, Turbo
Pascal scrolls the screen, just like a regular monitor, when you get to the bottom
of the display. You may, at any time, stop screen output by pressing the mouse
button and holding it down. When you release it, output continues. This is
handy to keep text from scrolling off the screen before you have read it.
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The Pascal Run-time Environment

The key to writing Standard Pascal programs is to simply type in the programs as
you see them in your textbook. By default, Turbo Pascal links in a set of routines
that implements Standard Pascal I/O on the Mac. These routines perform all the
initialization that your program needs to be able to run on the Macintosh. They
also create a simple Macintosh window that acts like the standard text screen of a
terminal or personal computer. It displays 25 lines of text, with up to 80 charac-
ters on each line. The screen-like window disappears when your program ends
execution.

Within this environment, the procedures Read, ReadLn, Write, and WriteLn
function as expected, handling carriage returns and form feeds. Turbo Pascal also
scrolls the display when necessary, as the second example program demon-
strates. What's more, you can directly position the cursor using GoToXY and
perform other screen operations using special Turbo Pascal procedures and func-
tions. These are described in Chapter 25.

The Standard Pascal environment is actually implemented as a group of four
units: PasSystem, PasInOut, PasConsole, and PasPrinter. A unit is a library or
collection of useful subroutines and other declarations.

The unit PasSystem is always used, since it provides certain functions needed
by all Turbo Pascal programs. The next two—PasInOut, and PasConsole—are
also automatically used unless you set the {$U-} option. The last one, PasPrinter,
is used only if you explicitly request it. For more details on using (or not using)
units, see Chapter 7.

Compiler Directives

Most Pascal compilers allow some form of compiler directives. These are com-
mands to the compiler, embedded in comment statements within your program.
They typically take one of two formats:

{$<letter>¢<+ or ->}
or
{$<letter> <filename>}

The first form is used to turn some option on or off. For example, {$R+} tells
the compiler to produce range-checking code, while {$R-} tells it not to.
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The second form usually directs the compiler to read from or write to some
file. For example, the directive {$I MYLIB.PAS} tells the compiler to include the
file MYLIB.PAS at this point in the program—in other words, to go to that file
and read from it as if the text in that file had been inserted in the current pro-
gram file.

All the compiler directives are documented in Appendix C, but here are some
of the most commonly used directives.

Input/Output Error Checking

An issue often addressed in Pascal textbooks and classes is how to make your
code “crashproof ”; that is, how to set it up so that users can’t cause your pro-
gram to stop due to input/output (I/O) errors. For example, say you ran the first
example program, PRODUCT, and, at the prompt Enter two integer values:,
typed in a real value (that is, a number with a decimal point). Your program
would halt, with a Mac system error box popping up. In a short program like
this, such an error isn’t a big bother. What if you were entering a long list of
numbers, however, and had gotten most of the way through before making this
mistake? You'd be forced to start all over again. So, making your program crash-
proof is important.

Like most compilers, Turbo Pascal allows you to disable automatic I/O error
checking and test for it yourself within the program. To turn off I/O error check-
ing at some point in your program, include the compiler directive {$I-}. This
instructs the compiler not to produce code that checks for I/O errors and brings
up the Mac system error box when one does occur. For example, we could mod-
ify the program PRODUCT to look like this:

progran Product;

var
A,B : Integer;
C : Real;
begin
Write(’Enter two integer values: ');
{$1-} { turn off I/0 error checking }
ReadLn(A,B);
{$I+} { turn it back on }
C := Rk + B;
WriteLn(‘The product is ‘,C:8:2);
ReadLn;
end.

Now, no matter what you enter for A and B, you won’t get a Mac system error
box. That doesn’t mean that there are no errors nor that A and B will have the
values you think they do. If you make a mistake, the corresponding variable just
gets the value zero (0).
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With I/0 error checking disabled, you can check for an error by calling the
standard Turbo Pascal function IOResult. IOResult returns an integer value cor-
responding to the appropriate Mac I/O result code (see Appendix C). If the
result is 0, then no error has occurred; otherwise, you'll probably want to take
some action, even if it’s just to ask for the values again. Your code might look like
this:

progran Product;
var
A,B : Integer;
C : Real;
begin
{$1-}
repeat
Write(’Enter two integer values: ‘);
ReadLn(A,B)
until IOResult = 0;
{$I+}
C := 1k + B;
WriteLn(‘The product is ’,C:8:2);
Readln;
end.

You need to be aware that each call to IOResult clears it; that is, sets it to zero.
Also, each I/O call (Write, WriteLn, Read, ReadLn, Assign, Reset, Rewrite, and
so on) sets IOResult to an appropriate value. For example, the following code
wouldn’t work properly:

progran Product;
var
A,B : Integer;
(o : Real;
begin
{$1-}
repeat
Write(’Enter two integer values: ‘);
ReadLn(A,B);
if IOResult <> 0 then
WriteLn(’Error on input!’)
until IOResult = O0;
{$I+}
C := A * B;
WriteLn(’The product is /,C:8:2);
ReadLn;
end.

There are two reasons this wouldn’t work. First, the call to IOResult in the if
statement if IOResult <> O clears it, so that the call in the until clause doesn’t
represent what happened with the ReadLn(A,B). Second, the call to WriteLn
changes IOResult anyway. If you did want to print this message out, you'd have
to do something like the following program.
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progran Product;

var
A,B,I0Code : Integer;
C ¢ Real;
begin
{$I-}
repeat
Write(’Enter two integer values: ’);
ReadLn(A,B);

I0Code := IOResult;
if I0Code <> O then
WriteLn(’Error on input!‘)
until IOCode = O;
{$I+}
C := 1+ B;
WriteLn(’The product is ’,C:8:2);
Readln;
end.

By saving IOResult in IOCode, we avoid both problems, since we only refer-
ence IOResult once (right after the place where we want to check for errors). For
more sophisticated applications, you can take some action (for example, print a

message) on the actual value of IOCode.

Range Checking: The {3R+/-} Directive

Another common compiler directive is {$R+/-}. It controls range checking of
array and string indexes, and assignment to scalar data types. By default, range

checking is turned off ({$R-}); you can turn it on with {$R+}.

This directive is used to track down errors caused by using array indexes that
are out of bounds or by assigning out-of-range values to scalar variables. Suppose

you had the following program:

program RangeTest;
var
Indx : Integer;
List : arrayl(1..10] of Integer;
begin
for Indx := 1 to 10 do
List[{Indx] := Indx;

Indx := O;
while (Indx < 11) do
begin

Indx := Indx + 1;
if List(Indx] > O then
List[Indx) := -List[Indx]
end;

for Indx := 1 to 10 do WriteLn(List[Indx]);

ReadLn;
end.
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If you type in this program, it will compile and run. And run. And run. It will,
in fact, get stuck in an infinite loop. Look carefully at this code: The while loop
executes 11 times, not just 10, and the variable Indx has the value 11 the last time
through the loop. Since the array List only has 10 elements in it, List[11] points
to some memory location outside of List. Because of the way variables are allo-
cated, List[11] occupies the same space in memory as the variable Indx. This
means that the statement

List[Indx] := -List[Indx]

is equivalent to
Indx := -Indx

Since Indx equals 11, this sets Indx to -11, which starts the program through
the loop again. That loop now changes additional bytes elsewhere, at the loca-
tions corresponding to List[-11..0].

In other words, this program can really mess itself up. And since Indx never
ends the loop at a value greater than or equal to 11, the loop never ends.

How do you check for things like this? Insert {$R+} at the start of the pro-
gram. When you run a faulty program, you'll get a Mac system error box. Press
the Resume button, and you're back in Turbo Pascal, at the right bracket (]) in
the statement if List[Indx] > 0. A box appears with the error message Range
check failed. This tells you that Indx has some value outside of List’s array
bounds (1..10).

You can leave range checking on all the time just by placing {$R+} at the start
of each program you write. However, the code generated to do range checking
does make the program larger and slower. Also, there are some situations—
usually in advanced programming—in which you might want or need to violate
range bounds, most notably in working with dynamically allocated arrays, or in
using Succ and Pred with enumerated data types.

You can selectively implement range checking by placing the {$R+} directive
at the start of the code that needs it, then placing the {$R-} directive at the end of
the code. For example, you could write the loop above as:

while Indx < 11 do
begin
Indx := Indx + 1;
{$R+}
if List(Indx] > O then
List[Indx] := -List[Indx]
{$R-}
end;

Range checking will only be performed in the if..then statement and nowhere
else in the program. Unless, of course, you have other {$R+} directives else-
where.
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Include Files: The {$I{file)} Directive

Another commonly used compiler directive, {$I(file)}, allows you to break one
large program file up into several smaller files. (Don’t confuse this with the
{$1+/-} directive used for 1/O error checking.) {$I(file)} directs Turbo Pascal to
include (file) during compilation. Turbo Pascal then opens this file and reads the
Pascal code from it, compiling it as if it were part of your program. When it
reaches the end of the included file, it closes the file and continues to compile
your program.

Most Macintosh-style applications can be organized into chunks, each chunk
containing related procedures and functions. If you were writing a bulky pro-
gram, you could organize it as follows:

prograr BigJob;

{$I BigJob.Def} { global declarations and definitions }
{$I BigJob.Util} { utility procedures/functions }
{$I BigJob.Menu} { menu-driven procedures/functions }
{$I BigJob.Event} { event-handling procedures/functions }
{$I BigJob.Init} { initialization and cleanup procedures }
begin

Initialize;

repeat

SystenmTask;

if GetNextEvent(theEvent) then
HandleEvent(theEvent)
until Finished;
Cleanup
end. { of program BigJob }

This program text is placed in a file called BIGJOB.PAS. In addition, five
other text files (BIGJOB.DEF, and so on) contain the appropriate parts of the
program. Since Turbo Pascal allows you to have up to eight windows open at the
same time, you can have all the files open for editing. That way, you can quickly
switch between them just by clicking inside the different windows, instead of
having to jump back and forth within one large file. You can also look at the
different portions side by side by arranging the windows on the screen, using the
Stack Windows or Tile Windows command in the Format menu.

There is a better way to break up large programs into chunks: units. For
example, you could place the definitions and routines in BIGJOB.DEF and
BIGJOB. UTIL into a single unit, compile it, and use it with a uses statement.
Likewise, you could turn BIGJOB.MENU, BIGJOB.EVENT, and BIGJOB.INIT
into units. Chapter 8 gives more details on how to do this.
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Output (Code) Files: The {$0 (file)} Directive

When you compile a Turbo Pascal program to disk, the resulting code file adopts
its name from the program header. For example, if your program header is

prograr Banzai;

then the code file created on the disk is called BANZAI. However, you can
override that default and request a specific code file name using the {$O (file)}
directive. This defines the name of the output (machine code) file. If you
changed your program to read

progran Banzai;
{30 MyNeatProgranm}

then a compile to disk produces a code file named MYNEATPROGRAM.

You now know how to get Standard Pascal programs running on the Mac
under Turbo Pascal. However, you can refer to Part II and Appendix A as your
programs grow more complex. They offer more information on the special fea-
tures that Turbo Pascal has to offer.

Of course, you don’t want to stop with “textbook” Pascal programs. You want
to write Mac-style programs, programs that use menus and windows and
graphics. The rest of Part I is designed to help you to do just that. Let’s lay some
groundwork in Chapter 6.
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c H A P T E R 6

Harnessing the Full Power of Your Mac

The Macintosh has some of the most sophisticated system software ever put
on a microcomputer. It gives most larger computers a run for their money. To
programmers, however, sophisticated usually means complex, and complex
rarely means easy to program. We'll discover whether that is true of the Mac in
this chapter. We'll introduce you to the concepts behind the Mac, explore bit-
mapped graphics, and explain the Toolbox and operating system tools and
resources that are at your disposal.

The Macintosh Philosophy

The designers of the Macintosh had the stated goal of designing a “computer
appliance,” the microcomputer equivalent of a toaster—that is, a system that
people with little computer experience or background could learn to use in a
very short time. By this criterion, the Mac is a smashing success: It is, to date,
the easiest computer for a naive user to learn. Most Mac software follows a
standard user interface, or format, so the typical Mac user can start using new
applications almost immediately.

The use of a standard interface is enforced by Toolbox (ROM-based) and oper-
ating system (RAM-based) routines that the Mac provides. Simply put, the
obstacles to not using the Mac’s routines are so great that most applications
conform to them. However, the routines are so comprehensive and complex that
the novice Mac programmer faces a steep learning curve.
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The basic Macintosh isn’t terribly complex in terms of hardware. It has a
68000 (or 68000-related) processor, a monochrome (black-on-white) bit-mapped
screen, RAM memory ranging from 128K in the older Macs to over 4M in
upgraded systems, Read Only Memory of either 64K or 128K, and some 1/0
hardware (serial ports, disk ports, and so forth). Fairly simple and straightfor-
ward stuff—until you look at what’s in that ROM.

The Mac pioneered four major microcomputer concepts: graphics-only dis-
play, visual user interface, event-driven software, and extensive system software.

Graphics-Only Display

Until the Mac appeared, most computers had text-only display or let you choose
between text and graphics. In both cases, the text display was a fixed font with
predetermined resolution and size (typically 80 columns of text in a 25-line dis-
play).

The Mac doesn’t have text-only display. Instead, everything is done with bit-
mapped graphics, including all text display. Bit mapping simply means that the
Mac screen is made up of a grid of bits, which make up the shapes—characters or
figures—that appear on your display. It’s explained further in the following
pages.

Because of bit mapping, writing and editing text on the Mac screen is more
complex than on other micros. But it also means that you have tremendous flexi-
bility in how that text is presented, in terms of size, style, and font design, and in
mixing text with graphics. In addition, you can change any of these elements and
redisplay them on screen countless times.

The Mac almost single-handedly spawned desktop publishing, although this
function is rapidly being adapted to other systems. The ability to produce high
quality documents with professional layouts used to be limited to companies that
could afford to buy or use very expensive typesetting equipment. Now, anyone
with a Mac can lay out and prepare slick documents. With access to a laser
printer (or even some of the newer typesetting machines), you can produce hard
copy that is comparable to copy from a professional printer.

Visual User Interfaces

The second Mac design concept is the visual user interface based on menus,
icons, windows, and a mouse as the input device. The concept itself isn’t new.
Neither is the interface unique to the Mac, since other microcomputers now
offer similar approaches. However, the Mac represents the first (and still the
best) attempt to make such a user interface available at a relatively low price.
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Event-Driven Software

The third major concept is event-driven software. As with the first two concepts,
this concept did not originate with the Mac, but it was the first micro to exten-
sively use it and, in fact, to make it a requirement for just about any application.

At the core of most Mac applications is an event loop that polls the Mac operat-
ing system for events (mouse clicks, keys pressed, menu selections, window
operations, and the like), then calls the appropriate internal routines to handle
those events. The goal is what Mac designers call modeless programs, where
most functions are available at any point. In modal programs, you have to enter
specific modes (insert mode, delete mode, command mode) to be able to per-
form the corresponding functions.

Extensive System Software

The fourth major concept is extensive system software (in ROM and on disk). The
software supports the user interface and event-driven programming approach,
and makes them standard for all applications. Earlier microcomputers had some
software (usually the Basic Input/Output System or BIOS) in ROM, but this was
usually on the order of 8K to 16K of ROM and supported rather primitive screen
and disk I/O functions. The original Mac came with 64K of ROM (increased in
later versions).

The current Mac ROM supports numerous and complex functions. The Mac
operating system provides a large set of standard functions and procedures, and

it also maintains an event queue that keeps track of events that applications must
deal with.

The irony of all this is that the original Macintosh was sorely crippled due to
hardware limitations, with no means of adding memory and no expansion slots or
hardware bus. However, Apple has learned some lessons since then, and the
current Macintosh Plus represents a far better environment for the Mac software
concepts. Future Mac products will undoubtedly continue to improve upon that.

Bit-Mapped Graphics

The standard Mac interface is a bit-mapped graphics display consisting of 342
lines, each line containing 512 pixels (picture elements, that is, dots). There are
175,104 pixels in all, each of which can be black or white. The display is called
bit-mapped because each pixel on the screen corresponds to a single bit (0 or 1)
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in memory (RAM). For that reason, this type of display is also referred to as
memory-mapped.

Since there are 8 bits in a byte, simple math shows that the screen takes up
21,888 bytes (or about 21K) of memory. By changing the values of those bytes,
you change what’s on the screen; it’s that simple. To draw a line (or other shape),
your program simply goes to the appropriate locations in memory and sets the
appropriate bits to 0 or 1. What's more, the Mac has an extensive and powerful
graphics library (QuickDraw) to make using these graphics even easier.

. However, manipulating a bit-mapped display can be complicated and tedious.
To draw a character on the screen, you can’t just poke an ASCII value into a byte
somewhere, as you can on most other microcomputers. Instead, the character
must be drawn bit by bit. A programmer can simplify matters somewhat by
maintaining a character font somewhere, with a bit map for each possible charac-
ter, but there are still issues of font size and style, of whether the font is letter-
spaced proportionally (that is, characters are spaced according to their width),
and so on. In addition, adding, deleting, and modifying text can get very elabo-
rate. Fortunately, the Mac comes with a large set of routines for text display,
manipulation, and editing. By using these, you don’t have to reinvent the wheel.

The real bonus of bit-mapped graphics is the marriage of graphics and text,
and the ability to manipulate both on the same display. You can readily mix
pictures and words, allowing diagrams to be inserted in documents and explana-
tions in schematics. On the Mac, you can draw a picture, then paste it into a
letter or report. And, of course, it is this flexibility that has made the Mac pre-
eminent in the field of desktop publishing.

The Mac User Interface

Three interrelated ideas form the nucleus of the Mac user interface:

* the mouse as an input device

* using icons, menus, windows, and other (mostly) graphic devices for informa-
tion and command selection

* an orientation toward modeless environments

The mouse may well be the most controversial of the three ideas. Debates
continue to rage over whether it aids or hinders user interaction. For that mat-
ter, users argue over whether the mouse should have one, two, or three buttons.

A graphics-based, visual system does require some sort of pointing device, and
the mouse works as well as or better than most.

The second idea, simply put, is that graphics convey more information than
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text (or, to abuse an old cliche, a picture is worth 1K words). By presenting files
as icons on a desktop, the selection and manipulation of files with the mouse is
fairly self-evident, especially for novice users. Likewise, the pull-down menu
makes it easy to view and choose available commands and options without having
to remember obscure command names or wade through multiple levels of text-
based menus. Within applications themselves, there tends to be a heavy orienta-
tion towards presenting data in graphic (rather than textual or numeric) form.

The third idea assumes that it is ideal to have as many options as possible
available to the user at any given time. Rather than have multiple levels and
numerous loads, the Mac attempts to keep all commands on one level, though
some commands or options may be disabled when appropriate.

For example, the File menu in Turbo Pascal is always on the menu bar, as are
the Edit, Search, Format, Font, Compile, and Transfer menus. However, not all
commands in those menus are available at all times. The user is spared the
tedium of keeping track of which mode he or she is in and the commands that
exist (or don’t exist) on that level.

Event-Driven Programming

The basic structure of most Macintosh applications is nearly identical, with a
main body that looks something like this:
begin
Initialize;
repeat
SystemTask;
if GetNextEvent(eventMask,theEvent) then
HandleEvent(theEvent)
until Done;
CleanUp
end.

The program does its setup with the user-defined routine Initialize. It then

enters a loop that continues until some condition (such as the user selecting the
command Quit in a menu) causes it to set the Boolean flag Done to True.

Within that loop, it performs two major tasks. First, it calls SystemTask (a
Toolbox routine), which allows the Mac operating system to update any desk
accessories that might be in use. Second, it calls GetNextEvent (another Toolbox
routine) to see if any events have occurred. If any have, it calls HandleEvent,
which is a user-defined routine that handles all the different events that might
occur. Such events include key presses; selection of menu items; mouse clicks;
windows being opened, closed, uncovered, or resized; and similar occurrences.

When the program is done, it calls the user-defined routine CleanUp, which
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takes care of any necessary tidying up. (This last task depends on the application
itself; usually, it means freeing allocations made in memory by the application
back to the system and similar tasks.)

This is quite different from most interactive computer software developed
before the Macintosh. In other systems, the program usually sits and waits for
the user to type in a specific command, then handles it. The programs tend to be
modal, with different levels and modes, each having its own command set. The
commands themselves are usually context-sensitive, with the same command (or
at least command sequence, that is, a given letter or word) holding different
meanings depending upon the current mode or state.

In a Macintosh application, most commands are usually available and applica-
ble. About the only time you can’t use a given command is when there is nothing
to use it on; for example, if you haven’t opened a window to edit text, then most
of the editing commands don’t make any sense. In the modeless approach, how-
ever, those edit commands can work on any text window, whether it be one your
application has opened, or one opened by a desk accessory.

Event-driven programming takes some getting used to, but once you under-
stand how it works and have seen a number of examples using it, it becomes
straightforward and easy to apply to different situations. In Macintosh applica-
tions, the format is so standard that you can move from program to program and
see almost identical code in the main procedures and immediate supporting
routines (such as HandleEvent).

Toolbox and Operating System Routines

To make the Mac user interface standard in most applications, Apple designed it
to be easy to follow and difficult to deviate from. This was particularly true of the
original Mac, which had 128K of RAM (much of which was consumed by the
video display and the operating system) and 64K of ROM (the Toolbox). Since
graphic applications tend to be memory intensive (that is, they need lots of
RAM), most developers on the Mac just didn’t have the extra memory to do
things their way. So they were forced to use the extensive libraries of procedures
and functions found in the Toolbox ROM and in the operating system itself.

The resulting uniformity in Mac software allows most Mac owners to use a
brand-new software package with little or no reference to the manual.

The Toolbox and operating system (OS) routines are organized into related
groups, often labeled managers or packages (not unlike units, which you’ll learn
about in Chapter 7). A list follows with the routine name and a brief description
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of what the routines and data types within each allow you to handle. The list is
arranged more or less in order of what you need to learn before moving on to the
next item, although some concepts are best understood as a group.

Resource Manager: Files can contain resources, such as definitions of menus,
windows, icons, and text strings, as well as chunks of code. These routines let
you access, identify, and manipulate resources within a given file.

QuickDraw: The heart of the Macintosh, this package contains the basic graphics
routines used by the other managers and packages.

Font Manager: You can display text on the Mac in different fonts, that is, with
differently designed character sets. This package helps you (and QuickDraw)
load or unload specific fonts from the disk for text display.

Toolbox Event Manager: These routines form the foundation for event-driven
programming. Besides GetNextEvent, this package also allows for direct polling
of the mouse, the keyboard, and the system clock.

Window Manager: The Mac allows you to set up multiple windows, each acting
like its own screen. This package helps you create, move, modify, update, and
delete windows.

Control Manager: Mac software often uses graphic controls — buttons, dials,
scroll bars, switches, and check boxes — for selection and display. These rou-
tines allow you to select and use predefined controls and to design your own.

Menu Manager: A menu bar across the top of the screen shows you the pull-
down menu options; selecting a particular menu allows you to examine com-
mands and pick a specific one. This package lets you create, manipulate, and
interrogate your menus (that is, go into the menu commands and find out how
they were set up).

TextEdit: TextEdit helps you edit text by providing routines to insert, delete,
select, and scroll text within a window, and to transfer text from one location (or
window) to another.

Dialog Manager: When a Mac application wants to bring something to the user’s
attention, it usually does so via a dialog box. This is a window with some informa-
tion (graphics and/or text) in it and with one or more ways to enter a command
(buttons, switches, text or numeric entry, and so on). This package helps you de-
sign and present dialog boxes, and to correctly interpret a user’s response to it.

Desk Manager: Most applications maintain the Apple menu option (the one on
the far left with the Apple logo instead of a name), which contains special pro-
grams known as desk accessories (covered in Chapter 8). Desk accessories can be
open and running even while your program is running, so you need to be able to
accept and receive their messages. Desk Manager routines allow you to detect
and handle actions required by the desk accessory.
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Scrap Manager: This package helps you transfer data (such as text) between
applications or between locations in a given application.

Toolbox Utilities: This is a collection of miscellaneous routines, including (but not
limited to) fixed-point math; string, byte, and bit, including logical operations on
long integers; and miscellaneous graphics-oriented routines.

Package Manager: A package is a set of routines and data structures stored on
disk (as resources in the SYSTEM file) and loaded into RAM as needed. Six
different packages are available through the Package Manager:

* the Binary-Decimal Conversion Package (conversions between decimal
strings and internal binary representations);

¢ the International Utilities Package (different languages’ character sets);
¢ the Standard File Package (selecting files for I/0O);
* the Disk Initialization Package (formatting blank disks);

* the Floating-Point Arithmetic Package (for IEEE-standard floating-point
math);

* the Transcendental Functions Package (for floating-point routines, such as trig-
onometric functions, logs, and financial functions).

Memory Manager: The Mac has a complex way to allocate relocatable blocks of
memory so that dynamic garbage collection can occur without disturbing any
program currently executing. When used properly, these routines ensure that
memory is correctly allocated or recovered.

Segment Loader: Programs that are unwieldy because of size can be divided up
into segments; each segment can be up to 32K in size. The Segment Loader
governs the execution, segment loading, and termination of an application.

Operating System Event Manager: The Toolbox Event Manager allows you to
query the operating system for events; the routines in this manager allow you to
work directly with the event queue that the operating system maintains.

File Manager: This manager handles just about everything having to do with
files, from high-level volume management to low-level file I/0.

Printing Manager: The Macintosh presents some special challenges in capturing
what’s on the screen or in a text file out to a printer. In conjunction with the
printer drivers found on your system disk, these routines allow you to print the
graphic images created by Mac software.

Device Manager: This package is a general version of the File and Printing
Managers. It lets you work with custom device drivers and perform I/O with
those devices.
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Disk Driver, Sound Driver, Serial Drivers: These routines give your software
control of the corresponding hardware items (floppy drives, DAC, RS422 ports)
on the Mac.

AppleTalk Manager: Apple has defined a simple local-area network (LAN) for
Apple products known as AppleTalk. This collection of data structures and rou-
tines allows you to communicate over that network.

Vertical Retrace Manager: This allows you to create interrupt-driven tasks that
are called every so many ticks, where a tick is one-sixtieth of a second and corre-
sponds to how often a vertical retrace interrupt occurs. A vertical retrace is one
cycle of redrawing the screen, and you can use the cycle as a timer to trigger a
routine.

System Error Handler: The one routine in this package, SysError, brings up the
system error dialog box (with the bomb in it). Not for casual use.

Operating System Utilities: Another collection of assorted handy routines,
including procedures and functions for pointer and handle manipulation, string
comparison, date and time operations, parameter RAM operations, and other
utilities.

With the proper use of these routines, your application will fit into the stan-
dard Macintosh mold. A regular Mac user will then be able to easily start it up
and use it.

Further Reading

If you want to do any serious programming on the Mac, there are a few standard
reference works:

* Inside Macintosh, written by a team at Apple and published in four volumes
(softbound) by Addison-Wesley, documents the hundreds of routines available
through the Toolbox and operating system. It is also available hardbound.

* Macintosh Revealed, volumes 1 and 2, written by Stephen Chernicoff and
published by Hayden (under its Apple Press line of books).

* MacTutor is a magazine dedicated to programming on the Mac; each issue
usually contains lots of short, working samples of code (call (714) 630-3730).

* How to Write a Macintosh Application, written by Scott Knaster and pub-
lished by Hayden.

* Macintosh Technical Notes, published by Apple Computer, Inc.

Now, let’s go on to the libraries—units—that the Mac provides.
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C H A P T E R 7

Units and Other Mysteries

In Chapter 5, you learned how to adapt standard Pascal programs for use by
Turbo Pascal on the Mac. What about non-standard programming—more specifi-
cally, Mac-style programming? Before anything else, you have to understand the
concept of units and of external and inline procedures and functions.

This chapter explains what a unit is, how you use it, and what predefined units
are available for your use. You'll also learn how to set up and use external and
inline procedures and functions. Among the other mysteries we delve into here
are traps and assembly-language routines.

What'’s a Unit, Anyway?

Turbo Pascal gives you access to a tremendous number of predefined constants,
data types, variables, procedures, and functions. Some are specific to Turbo Pas-
cal; others are specific to the Macintosh. There are literally hundreds of them,
but you hardly ever use them all in a given program. Because of their number,
they are split up into related groups called units. You can then use only the units
your program needs.

A unit is a collection of constants, data types, variables, procedures, and func-
tions. Each unit is almost like a separate Pascal program. It can even have a main
body that is called before your program starts and is used to do whatever initial-
ization is necessary. In short, a unit is a library of declarations that you can pull
into your program and use.
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All the declarations within a unit are usually related to one another. For exam-
ple, the QuickDraw unit has all the declarations for QuickDraw routines on the
Mac.

When a program uses a unit, all its declarations become available, just as if
they had been defined within the program itself.

A unit consists of two parts: the interface and the implementation. The inter-
face is the “public” part of the unit. It contains constants, data types, and vari-
ables. It also has a list of procedure and function headers. Any program using the
unit can use all these items. In other words, the program uses them as if they
had been declared within the program itself.

The implementation is the “private” section of the unit. The bodies of the
procedures and functions declared in the interface reside here. Additional con-
stants, data types, and variables can be declared and used within the implemen-
tation. Likewise, additional procedures and functions may exist in this section.
However, all these items are “invisible” to the program using the unit; the pro-
gram doesn’t know that they exist and can’t reference or call them. However,
these hidden items can be (and usually are) used by the “visible” procedures and
functions, that is, those routines whose headers appear in the interface. Chapter
8 explains more about both these sections.

The units your program uses have already been compiled; that is, they are
stored as machine code, not as Pascal source code. They are not Include files.
Even the interface section is stored in the special binary symbol table format that
Turbo Pascal uses. Furthermore, all the standard units (listed in the next para-
graph) are stored in the Turbo Pascal compiler/editor file and are loaded into
memory along with Turbo Pascal itself.

As a result, using a unit or several units adds very little time (typically less
than a second) to your program’s compilation time. If the units are being loaded
in from a separate disk file, a few additional seconds may be required because of
the time it takes to read from the disk.

Turbo Pascal provides 16 standard units for your use. Five of them—PasSys-
tem, PasInOut, PasConsole, PasPrinter, and SANE—are known as the Pascal
Run-time Support units and deal specifically with Turbo Pascal. The other 11
units—MemTypes, QuickDraw, OsIntf, Toollntf, PackIntf, MacPrint, FixMath,
Graf3D, AppleTalk, SpeechIntf, and SCSIIntf—allow access to the full range of
Macintosh Toolbox and operating system routines, including support for
AppleTalk, MacinTalk, and the SCSI hard disk port.

NOTE: In Turbo Pascal, each unit is assigned a specific unit number for iden-
tification purposes. You don’t really need to know these numbers. Just be aware
that negative numbers are reserved for the standard units and for assignment by
the UNITMOVER,; positive numbers are available for any units you create.
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How Are Units Used?

To use a specific unit or collection of units, you place a uses-clause at the start of
your program. The uses-clause consists of the keyword uses, followed by a list of
the unit names you want to use, separated by commas:
prograr MyProg;
uses thisUnit,thatUnit,theOtherUnit;

When the compiler sees this uses-clause, it adds the interface information in
each unit to the symbol table and links the machine code produced by the imple-
mentation to the program itself.

The units are added to the symbol table in the order given; this ordering can
be important when one unit uses another unit. For example, if thisUnit used
thatUnit, the uses-clause would have to be:

uses thatUnit,thisUnit,theOtherUnit;

or
uses thatUnit,theOtherUnit,thisUnit;

In short, a unit must be listed after any units it uses.

If you don’t put a uses-clause in your program, Turbo Pascal links in three
Pascal Run-time Support units anyway: PasSystem, PasInOut, and PasConsole.
These provide some of the standard Pascal routines, a number of Turbo-Pascal
specific routines, and also a model Pascal environment (complete with an 8025
screen, cursor-control and printer routines, and so on).

What if you don’t want some or all of these run-time units? You tell Turbo
Pascal not to use them by placing the {$U-} option at the start of your program;
only the PasSystem unit will be linked in. Any additional units you want must be
explicitly requested with the uses-clause. For example, if you are writing a Mac-
style application and don’t want to use the PasConsole unit (since you don’t need
it), your program might look like this:
progran MyMacProg;

{$0-} { don’t automatically use the run-time stuff }

uses PasInOut,MemTypes,QuickDraw,0SIntf,
ToolIntf,MacPrint,PackIntf;

This program does use one of the run-time units: PasInOut. However, since
you’ve put the {$U-} option in, you have to explicitly request the unit to use it.
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Pascal Run-time Support Units

Turbo Pascal provides a set of routines that make your Macintosh act like a stan-
dard terminal, allowing you to read from the keyboard and write to the screen
without all the tedious mucking about that the Mac usually requires of you.
These routines also let you do conversions, Pascal-style dynamic memory alloca-
tion, Pascal-style file I/O, and so on.

Turbo Pascal uses three units—PasSystem, PasInOut, and PasConsole—to do
all this. Two other units—PasPrinter and SANE—are provided for additional
support. Here’s a brief description of each unit, with its name and a listing of any
units it might require. Appendix D lists the interface sections of these units.

PasSystem
Units used: none

PasSystem implements the low-level support routines used by most programs,
including LongInt math, conversion between Real and Integer data types, string
and set handling, dynamic memory allocation, and byte-oriented procedures. It
is linked into every program, even if you use the {$U-} compiler option. (It’s
the only unit that doesn’t have an interface listing in Appendix D.)

PasInOut
Units used: none

PasInOut implements the standard Pascal 1/O routines (Read, ReadLn, Write,
WriteLn, Reset, Rewrite, and so on), as well as the Turbo-Pascal specific ones
(Close, Seek, Rename, Erase, and so forth). It also does all I/O and range-error
checking. If you look at the interface listing in Appendix D, you'll find that there
is very little you can use directly; instead, the compiler makes calls to specific
hidden routines in the implementation.

PasConsole
Units used: PasInOut

PasConsole is the unit that makes it easy to write textbook Pascal programs. It
creates a window that emulates a terminal screen 80 characters wide by 25 lines
deep. When this unit is used by a program or unit, any calls to Read or ReadLn
without a file variable are made from the keyboard and automatically echoed to
this window; likewise, any calls to Write or WriteLn without a file variable write
to that window. A number of cursor- and screen-control routines are available:
ClearScreen, ClearEOL, InsertLine, DeleteLine, and GoToXY. The functions
KeyPressed and ReadChar are there, too, as are the file variables Input and
Output. This unit also creates a new device (‘Console:’) that can be assigned to
any file of type Text. The user can then send output to the screen (instead of to a
disk file).
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PasPrinter
Units used: PasInOut

PasPrinter declares the text-file variable Printer and connects it to a device
driver that (you guessed it) allows you to send standard Pascal output to the
printer using Write and WriteLn. For example, having included PasPrinter in
your program, you could do the following:

Write(Printer, ‘The sum of ’,A:4,’ and ‘,B:4,’ is ’);
C:= 1R + B;
RriteLn(Printer,C:8);

Like PasConsole, this unit creates a new device (‘Printer:) which can be

assigned to any file of type Text. The user can then send output to the printer
(instead of to a disk file).

SANE
Units used: none

The SANE unit implements the Standard Apple Numeric Environment
(SANE). SANE is the basis for all floating-point mathematical calculations per-
formed by Turbo Pascal. Programmers who are interested in using SANE fea-
tures not directly supported by Turbo Pascal can access these features through
the SANE unit. For detailed instructions about SANE, see Chapter 26 and the
Apple Numerics Manual.

Macintosh Interface Units

The Macintosh is a complex, sophisticated microcomputer. Some of its power
comes from the built-in procedures and functions in the 64K or 128K of ROM
and the SYSTEM file on disk. These routines are documented in Inside Macin-
tosh, which breaks up the routines into a series of managers or packages:
resources, QuickDraw (graphics), fonts, events, windows, controls, menus,
TextEdit (text-editing), dialog boxes, and so on. In fact, you can think of these
managers as units built into the Mac itself.

The Macintosh Interface units that Turbo Pascal provides allow you to use
these Mac routines. Some of the units encompass several Mac managers or pack-
ages. This is to make things more manageable; otherwise, you might need 20 to
30 different units. Appendix D lists the interface sections of these units.

As with the Run-time Support units above, a brief description of each unit is
given, along with a list of the units it uses. Also, the Inside Macintosh chapters
that you can refer to are noted; the first number is the volume number, the
second is the chapter number.
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MemTypes
Units used: none
Chapters: “Mac Memory Management” (vol. I, chap. 3)

MemTypes defines special Mac data types, such as SignedByte, Ptr, Handle,
and Str255. That's all it does; there are no constants, variables, or routines
defined. It is used by every unit in this list and so must be included in any Mac-
style applications.

QuickDraw
Units used: MemTypes
Chapters: “QuickDraw” (I-6)

QuickDraw is a Macintosh graphics package that lets you perform complex
graphic operations quickly and easily. This unit defines all the constants, types,
variables, procedures, and functions needed to use QuickDraw. Since Quick-
Draw resides entirely in ROM and uses standard Pascal parameter-passing con-
ventions, the routines are all inline (see next item), and the unit itself contains no
actual code.

OSIntf

Units used: MemTypes, QuickDraw

Chapters: “Memory Manager™ (II-1), “Segment Loader’ (II-2), “OS Event
Manager” (II-3), “File Manager” (II-4), “Device Manager” (II-6), “Disk Driver”
(I1-7), “Sound Driver” (II-8), “Serial Drivers” (II-9), “Vertical Retrace Manager”
(I1-11), “System Error Handler” (II-12), “OS Utilities” (II-13)

The Macintosh operating system (Mac OS) is at the lowest level of Macintosh
operations. It performs basic tasks such as input/output, memory management,
and interrupt handling. Many of the Toolbox procedures and functions call Mac
OS routines to support their operations. The OSIntf unit declares the Pascal
interface to the Mac OS, naming the many constants, data types, variables, and
routines. Since few of the Mac OS routines abide by Pascal conventions, inline
code can’t be used; instead, the unit itself provides the “glue,” consisting of var-
ious additional external assembly-language routines. OSIntf is easily the largest
of the interface units.

Toollntf

Units used: MemTypes, QuickDraw, OSIntf

Chapters: “Resource Manager~ (I-5), “Font Manager” (I-7), “Toolbox Event
Manager” (I-8), “Window Manager” (I-9), “Control Manager” (I-10), “Menu Man-
ager” (I-11), “TextEdit” (I-12), “Dialog Manager” (I-13), “Desk Manager” (I-14),
“Scrap Manager” (I-15), “Toolbox Utilities” (I-16)

The Toolbox implements the Macintosh’s user interface features: windows,
menus, controls, dialog boxes, text editing commands, and so on. This powerful
set of tools helps you create sophisticated applications with comparatively little
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effort. A few of these routines need to be linked with routines via the ToolIntf
unit; most, though, can be taken care of with inline calls.

PackIntf

Units used: MemTypes, QuickDraw, OSIntf, Toollntf

Chapters: “Package Manager™ (I-17), “Binary-Decimal Conversion Package”
(I-18), “International Utilities Package” (I-19), “Standard File Package” (I-20),
“Disk Initialization Package” (II-14)

Packages are sets of data structures and routines that are stored as resources in
the SYSTEM file and brought into memory only when needed. They serve as
extensions to the Toolbox and Mac OS; the most useful (and most commonly
used) is the Standard File Package, which brings up the standard Mac dialog box
to open files or select a file name for output. PackIntf provides the interface to
those packages.

MacPrint
Units used: MemTypes, QuickDraw, OSIntf, Toollntf
Chapters: “Printing Manager” (II-5)

The MacPrint unit provides access to the Macintosh Printing Manager. The
Printing Manager is a set of RAM-based data types and routines that allow you to
use standard QuickDraw routines to print text or graphics on a printer. These
provide a device-independent interface to printer drivers, which enable you to
print on a specific device (ImageWriter, LaserWriter, and so on). One (or more)
of these printer drivers—usually found in the SYSTEM folder—must be avail-
able in order to use this package.

FixMath
Units used: MemTypes
Chapters: none

The FixMath unit is a collection of types and functions that implement fixed-
point real numbers. This unit is very useful for applications that require real
numbers but don’t need the accuracy of floating-point math. Fixed-point opera-
tions run much faster than regular floating point, so you can choose to sacrifice
precision for increased speed.

Graf3D
Units used: MemTypes, QuickDraw, FixMath
Chapters: none

Graf3D is a RAM-based, three-dimensional graphics package that sits on top
of QuickDraw. It implements 3-D GrafPorts and provides a complete set of 3-D
operations, including rotation, translation, scaling, and clipping.
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AppleTalk
Units used: MemTypes, QuickDraw, OSIntf
Chapters: “AppleTalk Manager” (1I-10), (see also Inside AppleTalk)

AppleTalk is the Macintosh local-area network — that is, the means by which
you connect a group of Macintoshes with printers, disks, other devices, and each
other. The AppleTalk Manager is used to communicate with devices connected
to an AppleTalk network. AppleTalk is implemented as two RAM-based device
drivers, .ATP and .MPP, and the AppleTalk unit declares the necessary Pascal
types and procedures for using them.

The drivers are in the resource branch of the file ABPACKAGE on the distri-
bution disk. If an application will use AppleTalk, then these drivers should either
be placed in the SYSTEM file or in the application itself. The latter is preferable,
since you can then move the application from disk to disk (and system to system)
without having to worry about whether or not the drivers are there. To add the
drivers to your file, put the following lines in your RMAKER resource file (see
Chapter 6 and Appendix C for more details on RMAKER):

Type atpl = GNRL
(0 (1B)
R

i\BPackage atpl 0

The atpl resource type must be in lowercase letters.

NOTE: The AppleTalk drivers may not be redistributed. They are licensed by
Borland International and are for your personal use only.

SpeechlIntf
Units used: MemTypes
Chapters: none

The SpeechIntf unit provides an interface to MacinTalk, a speech synthesizer
that runs under Mac OS as a driver. In real time, MacinTalk converts an ASCII
string of phonetic codes into synthetic speech. MacinTalk uses a special program,
READER, to convert English text into the phonetic codes used by MacinTalk.
The MacinTalk driver must be in the SYSTEM folder in order for your program
to work.

More information on Speechlntf is contained in the MacinTalk Toolkit docu-
mentation, in the December 1985 Mac Software Supplement Document from
Apple.

NOTE: MacinTalk may not be redistributed. It is licensed by Borland Inter-
national and is for your personal use only.
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SCSIIntf
Units used: MemTypes
Chapters: “The SCSI Manager” (4-31)

The SCSIIntf unit provides access to the Small Computer Standard Interface
(SCSI) port found on several models of the Macintosh. It allows you to determine
what devices are connected to the SCSI port and to communicate with them.

Calling Assembly-Language Routines

Yes, Turbo Pascal allows you to link in external subroutines written in 68000
assembly language. Full details, including how to pass parameters and return
function values, can be found in Chapter 27. Following is a quick explanation of
how to call assembly-language routines.

Before using an external procedure or function in a program, you must define
it. To define it, you write its procedure or function header, followed by the
keyword external:

procedure LowToUp(var Str : string); external;
function RotLeft(var L : LongInt; D : Integer) : LongInt; external;

Note that there is no body to the procedure or function, just the header state-
ment.

The procedure/function headers go wherever a regular procedure or function
can go. If they’re in a program, you can place them anywhere. If they're in a
unit, they can go either in the interface (if you want the user to be able to call
them) or in the implementation (if you don’t).

Next, write the appropriate routines, using Apple’s Macintosh Development
System (MDS) or an MDS-compatible assembler. The resulting .REL file must
be in MDS format (either version 1 or version 2). Refer to Chapter 27 for details
on how Turbo Pascal passes parameters to external routines, and how external
functions should pass values back.

Finally, you must tell the compiler what file to link to it, using the {$L} com-
piler directive. If you had assembled your assembly-language routines into a file
called MYSTUFF.REL, then you'd put the following directive somewhere in
your program:

{$L MyStuff.REL}

This directive can appear anywhere before the begin of the main body of your
program, or the begin of the initialization section in your unit (if you're writing
your own unit).
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When you compile your program, Turbo Pascal goes to MYSTUFF.REL,
copies the machine code into your application file, and creates the necessary
links.

Inline Code and Traps

In addition to external assembly-language subroutines, Turbo Pascal also allows
you to write internal machine-language code for your program. The key phrase
here is machine language, since the actual inline code is written as numeric
constants (preferably, though not necessarily, hexadecimal). The format for defin-
ing inline code is

<proc/func declaration>; inline <integer constant(s)>;

The constants are of type Integer, not of type LongInt. If more than one con-
stant is used, the constants are separated by commas. So, for example, you could
write the following:

procedure TextFace(Face : Style);
inline $205F, $1010, $3F00, $A84A;

This code would disassemble to the following 68000 code:

MOVEA.L  (A?)+,RD
MOVE.B (A0),DO
MOVE.W DO, (A7)-
DS.W $A848 ; trap to ROM routine

The Mac Toolbox implements most of its routines as traps. A trap is a special
instruction that causes the CPU to stop what it’s doing and attend to the trap. On
the 68000, for example, any instruction with the bit pattern $Axxx causes a trap.
The 68000 then calls a special trap-handling routine, which decodes the rest of
the instruction and decides what to do about it. On the Macintosh, that trap
handler looks at the rest of the bits and calls the appropriate ROM or RAM
routine before returning to the program where the trap occurred.

Confused? Just think of traps as do-it-yourself machine code instructions. If
you'll look through the unit interface listings for, say, QuickDraw, you'll see that
most of the procedures and functions are inline calls to traps. (The example
above, in fact, was taken from QuickDraw.)

One last bit of information about inline calls. An inline procedure or function
is not set up as a separate subroutine, so there is no JSR (jump to subroutine) to
an inline routine. Instead, whenever a call to an inline routine occurs, the com-
piler sets everything up as if it were going to make a subroutine call (pushing
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parameters and the return address on the stack). It then inserts the actual inline
code right after that. Say, for example, that you wrote the following code:
if BFlag then

TextFace([bold]l) { use bold type }
else TextFace([1); { use plain type }

At each call to TextFace, the compiler would generate the code to push the
parameter and return address onto the stack, then insert the four words found
above ($205F, $1010, $3F00, $A888).

Now that you've been introduced to units, you have two options as to where to
go next. If you're interested in writing your own units, go on to Chapter 8. If,
instead, you want to start writing Mac-style programs, skip to Chapter 9. How-
ever, you should read through Chapter 8 at some time.
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C H A P T E R 8

Writing Your Own Units

In Chapter 7, you learned how useful units could be. They provide an efficient
way to organize groups of data structures and subroutines for use in different
programs. In this chapter, you'll learn how to write your own units. Youll be
shown the general structure of a unit and its interface and implementation por-
tions, as well as initialization and compilation. Also included are a few program
examples.

A Quick Review of Units

A unit is a collection of constants, data types, variables, procedures, and func-
tions. Like a complete Pascal program, it can even have a “main body” that is
called before your program starts and does whatever initialization is necessary.
In short, it’s a library of declarations that you can pull into your program and use.
All the program elements in a unit are usually related to one another, so that a
unit tends to solve a set of problems or offer a set of capabilities. When a program
uses a unit, all its declarations become available, just as if they had been defined
within the program itself.

A unit consists of two parts: interface and implementation. The interface is the
actual collection of declarations that can be read by the program. This can
include constants, data types, variables, and headers for procedures and func-
tions. The implementation is where the bodies (the code) of the procedures and
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functions declared in the interface actually reside. Additional constants and the
like also can be declared and used within the implementation. These items,
however, are not available for viewing by the program using the unit.

Let’s talk in more detail about how a unit is laid out and what the different
sections do.

A Unit’s Structure

As mentioned above, a unit has a structure not unlike that of a program, but with
some significant differences. Here’s a unit, for example:
unit <identifier>(unit #);
interface
uses <list of units>; { optional }
{ public declarations }
inplementation
{ private declarations }
{ procedures and functions }
begin
{ initialization code }
end.

The unit header starts with the reserved word unit, followed by the unit’s
name (an identifier), just as a program has a name. A unit number, in paren-
theses, appears between the unit name and the semicolon terminating the
header. This number—a positive 16-bit integer constant—should be different
from any other unit number that your programs might use.

The next item in a unit is the keyword interface. This signals the start of the
interface section of the unit, that is, the section visible to any other units or
programs that use this unit.

A unit can use other units by specifying them in a uses-clause. If present, the
uses-clause appears right after the keyword interface. Note that the general rule
of a uses-clause still applies: If a unit named in a uses-clause uses other units,
those units must also be named in the uses-clause, and their names must appear
in the list before that of the unit using them.

As with a program, if a unit does not include a {$U-} directive, the PasInOut
and PasConsole units are automatically used by that unit. This further means
that a program using that unit would also have to use PasInOut and PasConsole,
even though they may not be required. In general, if a unit does not require any
of the functions provided by PasInOut and PasConsole, you should place a {$U-}
directive in the beginning of the unit.
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Interface

A unit provides a set of capabilities through procedures and functions—with
supporting constants, data types, and variables—but it hides how those capabili-
ties are actually implemented. It does this by breaking the unit into two sections:
the interface and the implementation.

The interface portion of a unit starts at the reserved word interface, which
appears after the unit header, and it ends when the reserved word implementa-
tion is encountered. The interface determines what is “visible” to any program
(or other unit) using that unit. In the unit interface, you can declare constants,
data types, variables, procedures, and functions. As with a program, these can
be arranged in any order, and sections can repeat themselves (for example, type

..var...<procs>...const ... type...const ... var).

The procedures and functions that are visible to any program using the unit
are declared here, but their actual bodies—that is, implementations—are found
in the implementation section. If the procedure (or function) is external, that
keyword should appear in the interface, and no redeclaration of the procedure
need occur in the implementation. If the procedure (or function) is inline, the
machine code (list of integer constants) should appear in the interface section,
and no redeclaration of the procedure should occur in the implementation. For-
ward declarations are neither necessary nor allowed. The bodies of all the regu-
lar procedures and functions are held in the implementation section, after all the
procedure and function headers have been listed in the interface section.

Implementation

The implementation section starts at the reserved word implementation. Every-
thing declared in the interface portion is visible in the implementation: con-
stants, types, variables, procedures, and functions. Furthermore, the implemen-
tation can have additional declarations of its own, although these are not visible
to any programs using the unit.

If any procedures have been declared external, one or more {$L (.REL file)}
directive(s) should appear before the begin marking the initialization section. If
there is no initialization section, then it can be anywhere before the final end of
the unit.

The normal procedures and functions declared in the interface—those that are
neither external nor inline—must reappear in the implementation. The proce-
dure/function header that appears in the interface should not appear in full in the
implementation. Instead, just type in the keyword (procedure or function), fol-
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lowed by the routine’s name (identifier). The routine should then contain all its
local declarations (labels, constants, types, variables, and nested procedures and
functions), followed by the main body of the routine itself. Say the following
declarations appear in the interface of your unit:

procedure Swap(var V1,V2 : Integer);
function Max(V1,V2 : Integer) : Integer;

The implementation should look like this:

procedure Swap;
var Temp : Integer;
begin
Temp := V1; V1 := V2; V2 := Temp
end; { of proc Swap }

function Max;
begin
if V1 > V2 then
Max := V}
else Max := Ve
end; { of func Max }

Routines local to the implementation (that is, not declared in the interface
section) should have their complete procedure/function header intact.

Initialization

The entire implementation portion of the unit is normally bracketed within the
reserved words implementation and end. However, if you put the reserved word
begin before end with statements between the two, the resulting compound
statement—looking very much like the main body of a program—becomes the
initialization section of the unit. When a program using that unit is executed, the
unit’s initialization section is called before the program’s main body is run. If the
program uses more than one unit, each unit’s initialization section is called (in
the order specified in the program’s uses statement) before the program’s main
body is executed.

The initialization section is where you initialize any data structures (variables)
that the unit uses or makes available (through the interface) to the program using
it. You can use it to open files for the program’s later use. For example, the
runtime unit PasPrinter uses its initialization section to make all the calls to open
(for output) the text file PRINTER, which you can then use in your program’s
Write and WriteLn statements.
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Compiling a Unit

You compile a unit using the same commands as when you compile a program.
Normally, you’d compile a unit to disk to be able to use it with all your programs.
However, if you have windows open for a unit and for a program that uses it, you
can compile the unit to memory. The compiler always looks in memory before
looking on disk, when searching for a unit named in a uses-clause.

When you compile a unit to disk, the resulting library file adopts its name from
the unit header. For example, if your unit header is:

unit MyUnit(l);

then the library file created on the disk is called MYUNIT. As with a program,
you can override that default and request a specific file name using the {$O
(filename)} directive. If you changed your unit to read:

unit MyUnit(1);
{30 MyLibrary}

then a compile to disk produces a library file named MyLibrary.

You may, in fact, compile several units to the same library file. Suppose you
have two units and that both include a {$O MyLibrary} directive. Every time
you compile one of them, the newly compiled unit replaces the older version in
the library file.

The icon used for unit library files is different from the one used for compiled
programs; it is an attaché-case (or briefcase), which represents something you
can “carry” from program to program. Also, unlike a compiled program, if you
double-click on a unit library file, the unit is not “executed.” Instead, the UNIT-
MOVER is launched, and the library file is “opened.” Chapter 11 contains a
complete explanation on using the UNITMOVER.

Using Your Units

Say you've written a unit called MYUNIT.PAS and compiled it to disk; the
resulting code file is called MYUNIT. To use it in your program, you need to
include two things: a {$U (filename)} directive to tell the compiler where to look
for the unit and a uses statement to tell the compiler that you're using that unit.
Your program might look like this:

program MyProg;

{$U MyUnit}

uses MyUnit;
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The unit name and the unit’s code file name don’t have to be the same. If you
compile the unit with the directive {$O MYUNITS.LIB} or change the code file
name to that under the FINDER, then the {$U} directive in the program would
have to read {$U MYUNITS.LIB}.

Now, suppose you had compiled the units MyFirst and MySecond with the
directive {$O MyLibrary}. To use all three units, you would have to use two {$U}
directives, both of them appearing before the uses-clause:
prograr MyProg;

{$U MyUnit}

{$U MyLibrary}
uses MyUnit,MyFirst,MySecond;

Depending on your Macintosh system, there is a limit to the number of files
you can specify with {$U} directives; it is at least ten for all systems, though.

The section at this end of this chapter, “UNITMOVER,” explains how you can
use this utility to simplify using units. Chapter 11 contains a complete explana-
tion on using UNITMOVER.

An Example

OK, now let’s write a small unit. We'll call it In¢Lib and put two simple integer
routines, a procedure and a function, in it. Here’s the unit:

unit IntLib(1);
{$0-}
interface
procedure Swap(var I,J : Integer);
function Max(I,J : Integer) : Integer;
inplenentation
procedure Swap;
var
Tenp : Integer;
begin
Temp := I; I := J; J := Temp
end; { of proc Swap }
function Max;
begin
if T > J then
Max := I
else Max :=d
end; { of func Max }
end. { of unit IntLib }

Type this in, save it as the file INTLIB.PAS, then compile it to disk. The
resulting unit code file is INTLIB.
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Following is a program that uses this unit:

progran IntTest;
{$U IntLib} { where to look for IntLib }
uses IntLib;
var
A,B : Integer;
begin
Write(’Enter two Integer values: ’);
ReadLn(A,B);
Swap(A,B);
WriteLn(’The max is ‘,Max(A,B));
ReadLn;
end. { of program IntTest }

Units and Large Programs

Up until now, you've probably thought of units only as libraries: collections of
useful routines to be shared by several programs. However, units can do some-
thing just as important: break a large program up into modules. In fact, units
give Turbo Pascal many of the advantages of Modula-2 and other modular lan-
guages, with few of their disadvantages.

Two other aspects of Turbo Pascal make this function feasible: its tremendous
speed in compiling and linking; and its ability to manage several code files simul-
taneously, such as a program and several units.

Typically, a large program is divided into units that group procedures by their
function. For instance, an editor application could be divided into initialization,
printing, reading and writing files, formatting, and so on. Also, there would be a
“global” unit—one used by all other units, as well as the main program—that
defines global constants, data types, variables, procedures, and functions.

The compiled version of each unit is stored in a unit library file. Each unit
references this file twice. First, it should reference it in a {$O (filename)} direc-
tive, since the compiled version of the unit should be put in that file. Second,
that same file name would need to be the first {$U (filename)} directive, so that it
could get the global declarations from the main unit (as well as any other unit it
might happen to use).

The skeleton program might look like this:

progran Editor;
{$0 My Editor}
{$T APPLMYED}
{$R Editor.Rsrc}
{$U Editor.Lib}

{ output file for application }

{ application type; creator ID = NYED }

{ resource file for this application }

{ library file with application’s units }
{$B+} set bundle bit }

{$0-} { disable automatic use of runtime units }

-~
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uses
MenTypes,QuickDraw,0SIntf,ToolIntf,PackIntf,MacPrint,
EditGlobals,
EditInit,
EditPrint,
EditRead,EditWrite,
EditFormat;

{ program’s declarations, procedures, and functions }

begin
{ main progranm }
end. { of program Editor }

One of the units—say, EditPrint—might look like this:

unit EditPrint(3);

{$0 Editor.Lib} { output file = library file }

{$0 Editor.Lib} { but uses units in libarary file as well }
{$0-} { disable use of runtime units }

interface

uses
MenTypes,QuickDraw,0SIntf,ToolIntf,PackIntf,MacPrint,
EditGlobals;

{ the rest of the interface }
implementation

{ implementation of the unit }
end. { of unit EditPrint }

A further refinement involves segmentation. Turbo Pascal allows you to break
your program up into segments, that is, chunks of machine code, each one no
larger than 32K bytes. The {$S+} directive instructs Turbo Pascal to create a
segmented code file, while the {$S (segname)} directive specifies into which
segment a unit or a collection of subprograms (procedures and functions) will go.

In the modified example below, the units are grouped into segments by their
function. The Mac units, as well as EditGlobals, go into the “blank” (or main)
segment, so that they will always be resident with the main body of the program.
The initialization unit (EditInit) resides in a segment by itself, so that it can be
disposed of once it has done its job. Likewise, the printing unit (EditPrint) is in
its own segment, so that it takes up memory only when printing is going on. The
modified section of the application looks like this:

{$B+}

{$5+} { enable segmentation }
{$0-}
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uses
{85 } MemTypes,QuickDraw,0SIntf,ToolIntf,PackIntf,
MacPrint,EditGlobals,
{$S Init } EditInit,
{$S Print } EditPrint,
{$S InOut } EditRead,EditWrite,
{$S Format } EditFormat;

Segments are loaded automatically by calling a procedure or function within
that segment. To unload a segment, you call the OS routine UnloadSeg, passing
to it the address of any procedure or function within that segment. For example,
if EditInit contained the procedure Initialize, then you would call

UnloadSeg(@Initialize);

You need to call this from somewhere outside of the segment containing Ini-
tialize. The main body of the application would probably be the safest place.

UNITMOVER

You don’t have to use a {$U(filename)} directive when using the Pascal Run-time
Support units or the Macintosh Interface units. That’s because all those units
have been moved into the actual Turbo Pascal compiler file. When you compile,
those units are always “visible” and able to be used if you want.

Suppose you have a well-designed and thoroughly debugged unit that you
want to add to the standard units, so that you don’t need a {$U} directive each
time you want to use it. Is there any way to move it into the Turbo Pascal
application file? Yes, by using the UNITMOVER utility.

You can also use the UNITMOVER to remove units from the Turbo Pascal file,
reducing its size and the amount of memory it takes up when loaded.

Summary

As you've seen, it’s really quite simple to write your own units. A well-designed,
well-implemented unit simplifies program development, since you just solve the
problems once and not for each new program. Furthermore, once you've
designed a useful unit, you can release it into the public domain without having
to disclose your source code. Others can benefit from your expertise, but you
won’t have to divulge your methods.
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C H A P T E R 9

Writing Your Own Macintosh Applications

In previous chapters, you learned how to write a standard Pascal program. Now
you can move into the meat of this manual: Macintosh programming. We'll now
show you parts of sample programs—contained in the EXAMPLES folder in the
Utilities & Sample Programs disk—that illustrate general Macintosh program-
ming techniques.

You're not going to learn everything in this chapter. Inside Macintosh, the
book on the Toolbox and the operating system, is over 1,200 pages. Macintosh
Revealed, the two-volume work on how to program the Mac, is some 1,100 pages.
Despite this chapter’s comparative shortness, however, you should learn the
basic skills necessary to program the Macintosh with Turbo Pascal.

The Demo Program

The EXAMPLES folder contains several sample programs. The following
sections explain the parts of these programs that exemplify Macintosh program-
ming techniques. One example program, MYDEMO.PAS, uses most of the
techniques mentioned in this chapter. It is a fairly simple Macintosh application
that uses menus, windows, dialog boxes, and graphics. Let’s start by making it
run, so that as you learn about it, you'll have in mind what the finished program
looks like.
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MYDEMO uses a resource file to define its menus, windows, and icon. The
source text describing the resources is located in the file MYDEMO.R (also in
the EXAMPLES folder). You can think of the text in MYDEMO.R as being like
an uncompiled Pascal program: It needs to be run through a “compiler” to be
useful. That “compiler” is RMAKER (for Resource Maker), so first run
RMAKER by double-clicking it (or use the Transfer menu, if you're in Turbo
Pascal). (RMAKER is described in detail in Chapter 12.)

Once you're in RMAKER, you'll get the standard file selector box; it only
shows files ending with .R. Find MYDEMO.R, select it (point at it with the
mouse, then click), and then click on the Open button. RMAKER then builds a
resource file (MYDEMO.RSRC) based on the descriptions in MYDEMO.R.
When it’s done, exit by clicking on the Quit button near the lower left corner of
the window. (You can also select the Other command in the Transfer menu, then
choose Turbo when the file selector comes up.)

Enter Turbo Pascal and open MYDEMO.PAS: Double-click directly on
MYDEMO.PAS or double-click on the Turbo Pascal icon, close the Untitled
window that’s automatically opened, select the Open command from the File
menu, find MYDEMO.PAS in the file selector list, and select it. Now, compile
and run MYDEMO: Select the Run command from the Compile menu (or type
(ZXR)). The compilation takes just a few seconds; MYDEMO runs, and the win-
dow and the menu bar (with four menus) appears.

Play around with MYDEMO for a while. Note that you can execute most
commands with keyboard equivalents. You can resize the window, drag it around
the screen, or close it (which will cause MYDEMO to halt execution and return
you to Turbo Pascal). You can run desk accessories using the Apple menu, or
bring up the About MYDEMO... dialog box.

When you're done, exit MYDEMO: Either click the Close box in the upper
left corner of the window, select the Quit command from the Edit menu, or type
(#)X@). Once you're back in Turbo Pascal, select the To Disk command from the
Compile menu (or type (Z)E]). Now exit Turbo Pascal. You should see the appli-
cation icon for MYDEMO. You can double-click the icon to run the program
again.

Let’s now look at how Mac applications are designed, by studying the parts
that make up a Mac program.
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Event-driven Programming

Back in Chapter 6, the concept of event-driven programming was introduced. As
you saw, the basic structure of most Macintosh applications is nearly identical,
with a main body that looks something like this:

begin { main body of program }

Initialize; { set everything up }
repeat { keep doing the following }
SystemTask; { update desk accessories }
CursorhAdjust; { update which cursor }
if GetNextEvent(everyEvent,theEvent) then { if there’s an event... }
HandleEvent(theEvent) { ...then handle it }
until Pinished; { until user is done }
Cleanup { clean everything up }

end. { of progran }

The program sets up once with the user-defined routine Initialize. It then
enters a loop that continues until some condition (such as the user selecting Quit
in a menu) causes it to set the boolean flag Finished to true.

Within that loop, it performs two major tasks. First, it calls SystemTask (a
Toolbox routine), which allows the Mac operating system to update any desk
accessories that might be in use. Second, it calls GetNextEvent (another Toolbox
routine) to see if any events have occurred. If any have, the highest priority
event is returned in the data structure theEvent. The program then passes the
event to HandleEvent, which is a user-defined routine that handles all the differ-
ent events that might occur. Such events include key presses, selection of menu
items, mouse clicks, and windows being opened, closed, uncovered, or resized.
When the program is ready to terminate, it calls the user-defined routine
CleanUp.

Event-driven programming assumes that most of your commands will usually
be available, so you need to anticipate how to handle them. That won’t be true
all the time; for example, a program may have editing capabilities, but any edit-
ing commands would be active and make sense only when there is a window
open for text editing. It is difficult to select, cut, and paste text when there’s no
text to cut and no window open for the text to be pasted to.

Event-driven programming takes some getting used to, but once you under-
stand how it works and have seen examples of it, it is easy to apply to different
situations. With Macintosh applications, the format is so standard that you can
move from program to program and see almost identical code in the main bodies
and immediate supporting routines.
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A Note on Programming Style

Turbo Pascal programs should be written to be as easy to read and modify as
possible. In the example programs on the disk, almost every line of code is
commented on. This may seem excessive, but the often cryptic nature of Macin-
tosh system calls makes it helpful to understand exactly what each call is doing,
and why. Too often, Macintosh sample programs assume too much understand-
ing on the part of the reader.

Emphasis has been placed on organizing programs into small, manageable
chunks of code. Mac hackers sometimes enjoy stuffing all the event handling into
a few gigantic case statements, usually embedded in loops and if/then/else state-
ments, with so much indentation and nesting that the program is unreadable.

Program Organization

Although Macintosh applications tend to have the same structure, you might not
notice it at first, given the way some of them are coded. Here is a skeleton
structure for a sample Macintosh program:

program SampleProgram;

global declarations

utility procedures and functions

menu-driven procedures and functions

event-handling procedures and functions

initialization and cleanup procedures
main body of program

You've already seen what the main body of the program looks like; let’s con-
centrate on another aspect, event handling.

82 Turbo Pascal for the Macintosh



Event Handling

To understand Macintosh applications, you must understand how to handle
events. Following is a sample of the HandleEvent procedure in a typical pro-
gram:

procedure HandleEvent(theEvent : EventRecord);

begin
case theEvent.What of
mouseDown : DoMouseDown(theEvent); { mouse button pushed }
keyDown : DoKeyPress(theEvent); { key pressed down }
autoKey : DoKeyPress(theEvent); { key held down }
updateEvt : DoUpdate(theEvent); { window need updating }
activateEvt : DoActivate(theEvent) { window made act/inact }
end

end; { of proc HandleEvent }

When an event occurs, the operating system creates an event record and
sticks it in a queue, ready for you to handle. To see if there’s one waiting, you call
GetNextEvent, a boolean function that returns true if there’s an event there for
you. You give it a mask of the events you're interested in; you can use the
predefined mask EveryEvent to look at all events. This event is passed to
HandleEvent, which takes care of it.

The key to all this is the predefined data type EventRecord, which is what
GetNextEvent passes back to you (through the parameter list). The data structure
looks like this:

type
EventRecord =

record
What : Integer; { event code }
Message : LongInt; { event message }
When : LongInt; { ticks since startup }
Where ¢ Point; { mouse location }
Modifiers : Integer { modifier flags }

end;

Here’s what each of the fields mean:

* What tells you what type of event has just occurred. There are a total of 16
predefined events, including 4 set aside for application use. Some common
events include mouse down, key pressed, key repeated, window activate/
deactivate, window update, and disk inserted.

* Message contains information specific to the event that has occurred. For key-
board events, it has both the ASCII and keyboard codes in it; for window
events, it has a pointer to the window involved; for disk events, it has the
drive number and File Manager result code.
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o When is the time that the event occurred. This is given in the number of ticks
(1 tick equals 1/60th of a second) that have elapsed since you booted the Mac.

» Where tells you the mouse’s location, in global coordinates, when the event
happened. The data structure Point is a variant record whose components can
be accessed either as V (Y coordinate) and H (X coordinate) or as VH[0] and
VH[1].

* Modifiers offers yet more specific information, when appropriate. Each piece
of information is flagged with a single bit, though not all bits are currently in
use. Items include the status of the mouse button, Command key, Shift key,
Option key, and Caps Lock key, and whether a window is being activated or
deactivated.

All this information gets passed to HandleEvent via the variable theEvent (of
type EventRecord). HandleEvent is just a case statement using the What field in
theEvent to determine which of the four procedures to call.

There are additional events you could check for (such as mouseUp, keyUp, and
so on), but these are sufficient for most programs. Here’s a brief explanation of
the types of events mentioned and what the handling routines will have to do:

* mouseDown: The user has moved the mouse to some point and pushed the
button. DoMouseDown determines where the mouse currently is (in a menu,
in a window, and so forth) and takes appropriate action (the following section
explains this further).

* keyDown: The user has pressed a key. All this program does is check to see if a
command-key combination was pressed; if so, it checks if the key is a menu
command and takes appropriate action.

* autoKey: The user is holding a key down. This program takes the same action
as for keyDown.

* updateEvt: A window has to be updated (redrawn) because of some event
(resizing or removing a blocking window, for example).

* activateEvt: A window has just been activated (brought to the front and high-
lighted) or deactivated (another window was activated).

As you can see, there can be a lot of background activity going on while your
program is running. Fortunately, your program doesn’t have to keep looking all
over the place to figure out what to do because the operating system keeps it
informed on what has happened, feeding it each event as the event occurs and is
processed. Your program then decodes the event and uses a case statement to
call the procedure best equipped to handle it. As you'll see, further decoding
often takes place to pin down exactly what the event was.
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Handling Mouse Events

The greatest variety of events comes from clicking the mouse’s button. The rou-
tine DoMouseDown determines which window (if any) the mouse was in when
the clicking took place and where exactly it happened. Like HandleEvent,

DoMouseDown is mostly a case statement:

procedure DoMouseDown(theEvent:EventRecord);
var

Location : Integer;
theWindow : WindowPtr;
MLoc : Point; WLoc : Integer;

begin
MLoc := theEvent.Where; { get mouse position }
WLoc := PindWindow(MLoc,theHRindow); { get window,window location }
case WLoc of { handle locations }
InMenuBar : HandleMenu(MenuSelect(MLoc)); { in the menu }
InContent : HandleClick(theWindow,MLoc); { inside the window }
InGoAvay : HandleGoRway(theRindow,MLoc); { in the go away box }
InGrow : HandleGrow(theWindow,MLoc); { in the grow box }
InDrag : DragHindow(theRindow,MLoc,DraghArea); { in the rag bar }
InSysWindow : SystemClick(theEvent,theWindow) { in a DA window }
end

end; { of proc DoMouseDown }
DoMouseDown now has a number of sub-events to process, namely:

InMenuBar: The user has selected a command from one of the menus in the
menu bar. Decode the command and take appropriate action.

InContent: The user has clicked the mouse down in the text or contents area of
the window. If the window is the currently active one, take whatever action is
appropriate (if any); otherwise, make it the active window.

InGoAway: The user has clicked the Close box in the window. If this is the
active window, then you should close the window and possibly exit the pro-
gram as well. If it’s not the active window, make it the active window.

InGrow: The user has clicked the mouse in the grow box in the lower right
corner of the window. Call some standard Toolbox routines (GrowWindow,
SizeWindow, InvalRect) to let the user change the size and redraw the now-
changed window.

InDrag: The user has clicked the mouse down in the drag bar at the top of the
window. Call the Toolbox routine DragWindow, which handles everything for
you.
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* InSysWindow: The user has clicked the mouse in a desk accessory window.
Call the Toolbox routine SystemClick, which passes the event information on
to the desk accessory (which then handles things itself).

Two of these events (InDrag and InSysWindow) are handled by a simple call to
a Toolbox routine. The other four (InMenuBar, InContent, InGoAway, and
InGrow) result in calls to other procedures (HandleMenu, HandleClick, Handle-
GoAway, and HandleGrow, respectively). Let’s talk about each of these.

Menu Commands

The procedure HandleMenu decodes the mouse position and figures out which
menu and which item in that menu were selected. It uses a case statement to
select the action for the appropriate menu; the menu value is the ID assigned
when the menu is created (more on this in the section on initialization near the
end of this chapter). The commands in a menu are numbered from the top down,
with the first command having a value of 1. The action itself is usually a second
case statement, based on the menu item (or command) number. Here’s a sample
HandleMenu routine:

procedure HandleMenu(MenuInfo : LongInt);

var
Menu : Integer; { menu number that was selected }
Iten ¢ Integer; { item in menu that was selected }
B : Boolean; { dunmy flag for SystemEdit call }
begin
if MenuInfo <> 0 then
begin
ClearWindow(MainPtr); { we’re clearing the window }
PenNormal; { set the pen back to normal }
HideCursor; { turn off the cursor }
Menu := HiWord(MenulInfo); { £ind which menu the command is in }
Item := LoWord(MenuInfo); { get the command number }
case Menu of { and carry it out }
ApplMenu : if Item = 1 then
DoRAbout { bring up "About..." window }
else DoDeskAcc(Item); { start desk accessory }
FileMenu : case Item of
1 : NewFile; { start a new file window }
2 : OpenFile; { open an existing file }
3 : SaveFile; { save file to disk }
4 : Quit; { quit the progranm }
end;
EditMenu : case Item of
1 : Undo; { undo last operation }
3 : Cut; { cut to clipboard }
4 : Copy; { copy to clipboard }
5 : Paste; { paste from clipboard }
b : Clear; { clear clipboard }
8 : ShowClipBoard; { show clipboard window }
end

{ other application menu case statments go here }
end; { case of Menu }
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HiliteMenu(0); { reset menu bar }
if Menu = IOMenu then
UpdateMenu; { make any changes needed }
ShowCursor { turn the cursor back on }
end
end; { of proc HandleMenu }

When an item in a menu is selected, the name of that menu (in the menu bar
at the top of the screen) is highlighted, that is, inverted to white-on-black (called
inverse or reverse video). When you are done processing the menu command,
restore the menu bar to normal: call HiliteMenu(0), which is at the bottom of
HandleMenu. Another procedure is called before you can leave HandleMenu:
UpdateMenu, a local procedure that tests to see if certain items need to be
enabled or disabled.

Notice that in the EditMenu, item numbers 2 and 7 are not used. These are
used by division lines and are not selectable as menu items.

Enabling and Disabling Menu Items Just as the line separators in menus are
disabled, you have the ability to disable (and enable) specific items in specific
menus. For example, in the standard Apple edit menu, the paste item is not
enabled until something is placed on the Clipboard. To enable and disable menu
items, call the standard Macintosh procedures Enableltem and Disableltem.

Here’s a sample UpdateMenu, with the SetltemState procedure it calls:
rocedure SetItemState(Mndx,Indx : Integer; Flag : Boolean);

egin
if Flag then { test enable/disable flag }
EnableItem(MenuList(Mndx1,Indx) { enable menu iten }
else DisableItem(MenuList{Mndx1,Indx) { disable menu item }

end; { of proc SetItemState }

rocedure UpdateMenu;

egin
SetItenState(EditHenu,l,True); { edit Cut is always active 1}
SetItemState(EditNenu,2,True); { edit Copy is always active }

SetItemState(EditMenu,3,ClipBoardFull) { edit Paste depends on flag }
end; { of proc UpdateMenu }

UpdateMenu calls the procedure SetltemState, passing the menu index, the
item number, and a Boolean flag. SetltemState, in turn, decides whether to
enable or disable the item based on the Boolean value passed to it. It uses the
menu index passed to it to choose the particular menu handle from MenulList
(an array of type MenuHandle), then uses that and the item number to call either
Enableltem or DisableItem—Toolbox routines that do just what their names sug-
gest.

In the UpdateMenu procedure, the Edit menu command Paste is enabled or
disabled depending on the Boolean flag ClipBoardFull.
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Check Marks You can have a menu item that uses a check mark and a global
flag to keep track of a particular option. When this option is selected, a check
mark is placed by the item in the menu; when it is de-selected, the check mark
disappears.

The following general-purpose routine called ToggleFlag provides check mark
operations:

procedure ToggleFlag(var Flag : Boolean; Mndx,Indx : Integer);
var

Ch : Char;
begin
Flag := not Flag; { toggle flag (for you) }
if Flag then { if flag is true... }
Ch := Chr(CheckMark) { then check item in menu }
else Ch := Chr(NoMark); { else clear any checkmark }
SetItemMark(MenuList(Mndx1,Indx,Ch) { put char by item in menu }

end; { of proc ToggleFlag }

ToggleFlag takes three parameters: a Boolean variable (Flag), the menu num-
ber (Mndx), and the item number (Indx). ToggleFlag then toggles Flag; that is, if
Flag was set to true, it is set to false, and vice versa. Having done that, it sees if
Flag is now true or false: If Flag is true, it places a check mark at item Indx in
menu Mndx; if Flag is false, it places a blank there, erasing any existing check
marks. The standard Macintosh procedure SetItemMark puts the character next
to the menu item.

The “About...” Box Most menu commands call other procedures that take
the desired action. The first menu (ApplMenu) is the Apple menu; it appears at
the far left of the menu bar as the Apple logo. When you pull down this menu,
the first item you see is About <the progran nane>. If this is selected, the proce-
dure DoAbout is called. Here’s a sample procedure definition:

procedure DoAbout;

var
thelten : Integer;
AboutPtr : DialogPtr;
S1,5¢,53,84 : Stress;

begin
SetCursor(CursList[myCursorl**); { set to my cursor }
ShowCursor; { and turn it back on }
S} := ‘This is a Sample Program’; { set up four strings for the }
S2 := ’ brought to you by the ’; { Rbout dialog box }
S3 := ' friendly folks at’;
S4 := ’ BORLAND INTERNATIONAL’;
ParamText(S1,S2,S3,54); { set up as parameter text }
AboutPtr := GetNewDialog(AboutID,NIL,Pointer(-1)); { get a dialog box }
ModalDialog(NIL,theIten); { put dialog box up; get result }
DisposDialog(AboutPtr); { get rid of dialog box }
SetCursor(Arrow)

end; { of proc DoAbout }
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DoAbout is a small routine that displays a box with some information about
the program, then waits for you to click on the OK button. Once that’s done, it
removes the box and lets the program continue executing. It uses a predefined
dialog template in a resource file to create the display box.

This dialog is known as modal dialog, because the entire program stops until
you do something. The Toolbox routine ParamText provides a means of substitut-
ing text strings in parameter items in subsequent dialog or alert boxes. The
Toolbox routine GetNewDialog uses the AboutID to retrieve a predefined dialog
box from a resource file. This allows you to have standard dialog boxes whose
items have similar types, locations, and contents. The Toolbox routine Modal-
Dialog sets up the dialog box for you; the routine DisposDialog then gets rid
of it.

Handling Desk Accessories The Apple menu also allows you to bring up
desk accessories from within your program. The idea behind desk accessories is
that you should be able to access them while you're in the middle of an applica-
tion. Chapter 10 discusses desk accessories and how to write your own; for now,
let’s see how to make sure your program supports them.

First, you must be sure to set up the Apple menu. This should be the first
(leftmost) menu. To define the Apple logo as the title, use the character with hex
value 14; in the resource file, you can do this by giving the logo the title \14.

Here’s what a resource file would look like:

TYPE MENU

,1000 ; resource ID number
\14 ; Apple symbol for title
Rbout My Demo... ; top item--for ‘About’ box
(- ; line separator

In the initialization procedure, after reading the menu data in (using Get-
Menu), you need to add the desk accessories to the menu. You do this by calling
AddResMenu(<menuhandle>, ‘DRVR’), where (menuhandle) is the handle of your
first menu.

Within your main loop, you need to call SystemTask to give the operating
system a chance to pass control to any desk accessories that might be executing.
If you get the mouse event inSysWindow, call SystemClick in order to let the
desk accessory handle it; likewise, the mouse event inGoAway must call
CloseDeskAcc if the window being closed is a desk accessory.

If you select one of the desk accessories from the Apple menu, you need to
start it up. The procedure DoDeskAcc—which HandleMenu calls for any item
from the Apple menu other than the first one—does this by calling Getltem to
get the name of the desk accessory selected, then calling OpenDeskAcc with that
name.
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You should support the standard Edit commands—Undo, Cut, Copy, Paste,
and Clear—since a number of desk accessories rely upon these. Set them up as
jtems 1, 3, 4, 5, and 6, respectively, in 2 menu. When one is selected, pass its
value (less one) to the OS function SystemEdit, which will return true if that edit
command was for a desk accessory. If SystemEdit returns false, then handle the
command in the manner appropriate for your application.

Clicking Windows

The following procedure handles clicking the mouse. The code checks to see if its
own window is being clicked and if that window is the active window. If it isn’t,
then it makes its window active:

procedure HandleClick(WPtr : WindowPtr; MLoc : Point);

begin
if WPtr = MainPtr then { if this is our window... }
if WPtr <> FrontWindow { and it’s not in front... }
then SelectWindow(WPtr) { ...then make it active }

end; { of proc HandleClick }

For other applications, though, more can (and needs to) be done. Some pro-
grams have a picture, layout, or graph of some kind in the window. In that case,
you need to look at exactly where the mouse was clicked and determine what
action to take. For example, pointing at a section of the picture could bring up a
dialog box telling the user what that section is and allowing the user to modify .
some data related to it.

For a text-editing application, you click in the window in order to move the
cursor to a different spot for text entry. In that case, you need to make the
necessary calls to relocate the I-beam (text) cursor and to make sure that any text
typed after that is inserted at the proper spot in the text record.

The Close Box

A window can have a Close (or go-away) box in its upper left corner. The user
closes windows by pointing at the box with the mouse, then clicking once. On
most text editors, including Turbo Pascal, the window closes, but the application
continues to execute. In the following procedure, the flag Finished is set to true
when that happens, leaving a procedure called CleanUp to actually close the
window:

procedure HandleGoAway(WPtr : WindowPtr; MLoc : Point);
var

WPeek : WindowPeek; { for looking at windows }
begin

if WPtr = FrontWindow then { if it’s the active window }
begin

WPeek := WindowPeek(WPtr); { peek at the window }

if TrackGoRway(WPtr,MLoc) then { and the box is clicked }
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begin
if WPeek*.WindowKind = userKind then { if it’s our window }

Finished := true { then time to stop }
else CloseDeskAcc(WPeek”.WindowKind) { else close DeskAcc }
end
end
else SelectWindow(WPtr) { else make it active }

end; { of proc HandleGoRAway }

As you can see, HandleGoAway doesn’t act immediately upon the Close box
being clicked. Instead, it calls the Toolbox function TrackGoAway, which returns
a value of true or false. TrackGoAway allows the user to have a change of mind;
by moving the mouse away from the Close box without releasing the mouse
button, the user cancels the close request.

This routine also handles closing desk accessories. It does this by checking
what kind of window is open. During initialization, the main window was set to
type userKind (=8), while the desk accessories use their reference numbers to
identify their windows. Indeed, that’s how the desk accessory is closed: by using
the WindowKind field as the reference number to identify which desk accessory
to close.

The Grow Box

A window also can have a Grow box in the lower right corner. The user can point
the mouse here, hold the button down, and resize the window by dragging the
mouse around. More accurately, resizing takes place when the program calls
GrowWindow, and what actually gets moved around is a dotted outline of the
window. GrowWindow then returns the new width and height, with the position
of the upper left corner being the fixed point of reference. The window is resized
by calling SizeWindow with the new width and height. InvalRect is then called
to mark any portions of the window that might no longer be valid because of the
resizing. Here’s a sample routine:

procedure HandleGrow(WPtr : WindowPtr; MLoc : Point);
type
GrowRec =
record
case Integer of
0 : (Result : LongInt);
1 : (Height,Width : Integer)
end;
var
GrowInfo : GrowRec;
begin
if WPtr = MainPtr then { if it’s our window }
with GrowInfo do
begin
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Result := GrowWindow(WPtr,MLoc,GrowRrea); { get amt of growth }

SizeWindow(WPtr,Width,Height,true); { resize window }
InvalRect(WPtr*.portRect) { set up for update }
end

end; { of proc HandleGrow }

This approach is a lazy one; the entire window is marked for updating. In your
own applications, you can (and may want to) mark just those sections that have
changed and need to be redrawn. In either case, the system issues update
events (updateEvt) as needed to redraw things.

You may notice that one of the parameters to GrowWindow is the rectangle
GrowArea. This defines the bounds of growth, that is, the minimum and maxi-
mum width and height for the window. GrowArea is initialized in the procedure
Initialize. The minimum size is set there (rather arbitrarily) to 50 pixels wide by
20 pixels high. The maximum size is based on the screen dimensions, which are
not assumed but instead are copied from Screenbits.Bounds and adjusted
inwards slightly.

The Drag Bar

A window can have a drag bar across the top. The user can point at the drag bar,
hold the mouse down, and move the window around the screen. This is an easy
event to handle; just call the Toolbox routine DragWindow. If any update events
are required—for example, if the window were partially off the screen and you
just dragged it all the way back on—the system issues the necessary update
events.

Note that DragWindow, like GrowWindow, gets passed a bounding rectangle
called DragArea. It determines how far off the screen you can move the window.
The idea, of course, is to avoid moving the window off the screen in such a
manner as to prevent you from moving it back in. As with GrowWindow, Drag-
Window is set using the values in Screenbits. Bounds.

Handling Keyboard Events

After this discussion of mouse events, keyboard events will seem relatively sim-
ple and straightforward. There are three keyboard events: keyDown (a key is
pressed); keyUp (a key is released); and autoKey (a key is held down long enough
for it to start automatically repeating). The second one is only of interest in
special cases, and you can often handle the third the same as the first. So you
only have to worry about one event at this point: A key (or combination of keys)
has been pressed.
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For a regular application, a key press signals one of three things. First, if text
entry is active, it means that a text record is being modified, that is, you're typing
text in. Second, your program may interpret certain key combinations as special
commands. Third, the key press may be the command-key ((&)) equivalent of a
menu selection.

If you pull down most Macintosh application menus (except for the Apple
menu), you'll see the command-key equivalents beside the items. To invoke a
given command, hold the command key down and press the appropriate
letter. Here’s the routine to handle it:

procedure DoKeypress(theEvent : EventRecord);
var

KeyCh . Char;
begin
%f itheEveut.modifiers and cndKey) <> O then { menu key command }
egin
KeyCh := Chr(theEvent.Message and charCodeMask); { decode character }
gandleuenu(uenuKey(KeyCh)) { get menu and item }
en
else SysBeep(1l) { do something }

end; { of proc DoKeypress }

The Modifiers field in theEvent includes a bit that is set to 1 if the command
key was held down when the event happened. You can test for that bit with a
predefined mask, cmdKey. If you pass the character to the Toolbox function
MenuKey, it will return a LongInt value containing the menu and item numbers.
Pass these numbers to your menu-handling routine, which will split them up
into two integers to separate the menu and item numbers.

Handling Update Events

The Macintosh keeps track of a lot of things for you. For one, it tells you when
some portion of a window needs to be redrawn, because of resizing or removing a
covering window. This is known as an update event (updateEvt), and it requires
special handling. For one thing, you need to be able to redraw your entire win-
dow (or some portion thereof) at any time. This isn’t that difficult for a text-
editing window, since the text is stored off in memory and is written to the
window as needed. However, it’s a little trickier for a window with graphics. You
either have a procedure (or set of procedures) that can recreate what you have on
the screen, or you need to write to a bitmap that’s in memory and copy it to the
window as needed.
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To handle an update event, follow a given sequence. Here’s an example:
procedure DoUpdate(theEvent : EventRecord);

var
SavePort,theWindow : WindowPtr;
begin
theWindow := WindowPtr(theEvent.Message); { find which window }
if theWindow = MainPtr then { only update ours }
begin
getCursor(CursList[watchCursor]“); { set cursor to watch }
GetPort(SavePort); { save current grafport }
SetPort(theWindow); { set as current port }
BeginUpdate(theWindow); { signal start of update }
{ and here’s the update stuff! }
ClearWindow(theWindow); { do update stuff }
{ now, back to our program...}
EndUpdate(theWindow); { signal end of update }
SetPort(SavePort); { restore grafport }
SetCursor(Arrovw) { restore cursor }
end

end; { of proc DoUpdate }

This saves the current grafport into SavePort and makes theWindow the cur-
rent port so that you can write to it. BeginUpdate limits all output to the section
of theWindow that needs updating. You then do whatever redrawing is needed.
When you're done, EndUpdate lifts those limits, and SetPort(SavePort) restores
the old grafport.

Handling Activate Events

On the Macintosh desktop, only one window can be active at any one time. This
doesn’t mean that changes can’t occur in other, inactive windows; it just means
that, if there is more than one window on the screen, the highlighted front
window is considered the active window. The Macintosh interface states that
clicking on a window makes it active (and all others inactive); other processes
(including a direct call to SelectWindow) can also make a window active. Here’s
an example:

procedure DoActivate(theEvent : EventRecord);

var
I : Integer;
AFlag : Boolean;
theWindow : WindowPtr;
begin
with theEvent do
begin
theWindow := WindowPtr(Message); { get the window }
AFlag := 0dd(Modifiers); { get activate/deactivate }
if AFlag then
begin { if it’s activated... }
SetPort(theWindow); { make it the port }
FrontWindow := theWindow; { know it’s in front }
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DrawGrowIcon(theWindow); { set size box }

end
else
begin
SetPort(ScreenPort); { else reassign port }
if theWindow = FrontWindow { if it’s in front }
then FrontWindow := NIL { ...then forget that }
end;
if theWindow = MainPtr then
begin { if it’s our window }
SetItemState(EM,1l,not AFlag); { update edit cmds }
for I := 3 to & do
SetItemState(EM,I,not AFlag);
SetItemState(EM,8,AFlag); { update Quit command }
for I := PM to IN do { update other menus }
SetItemState(I,0,AFlag);
DrawMenuBar { update menu bar }
end
end

end; { of proc DoActivate }

You test for activate/deactivate using the lowest bit on the Modifiers field of
theEvent. If the window is being activated, you need to call SetPort to make it
the current grafport; if it’s being deactivated, you need to do something else,
depending on your application. SetPort is called with the variable ScreenPort,
which earlier (in Initialize) had been set to the entire screen with a call to
GetWMgrPort. Whether the window is being activated or deactivated, a call is
made to DrawGrowlIcon.

Handling Other Events

There are a few other events that can occur. The disk inserted event (diskEvt)
can usually be ignored; the only time it's important is during file selection, and,
in that case, the Standard File Package reacts automatically. The network event
(networkEvt) has to do with getting a packet via AppleTalk; see the appropriate
documentation in Inside AppleTalk, as well as Chapter 10 in Volume 2 of Inside
Macintosh, for more details. Likewise, the nature of a driver event (driverEvt) is
dependent upon the device driver issuing it.

The last four events are application-defined events: applEvt, app2Eut,
app3Evt, and app4Evt. Since they're application defined, how do they get into
the event queue in the first place? Simple: you put them there with the OS
function PostEvent. PostEvent takes two parameters: the event code (which
should be applEvt..app4Evt), and the event message, a LongInt value that can
be almost anything you want it to be (including a pointer to some data structure).
The event code gets assigned to What, and the event message to Message;
the other fields (Where, When, Modifiers) are all set for you by PostEvent.
PostEvent then returns a result code (0=0k, 1=Event code not allowed) telling
you how it did.
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Data Structures

Until now, we’ve shown many program parts without talking too much about the
data structures involved, other than the type EventRecord.

First, you need to understand that Mac software is heavily based on the ideas
of pointers and handles. If you've programmed in Pascal or C before, you are
probably familiar with the concept of a pointer: It’s a variable that contains,
instead of data, the address of where some data is stored. A handle is just a
pointer to a pointer. Handles are used heavily in Mac programs, because they
allow the Mac to perform memory reorganization—moving data structures from
one place in memory to another—without changing any values.

Here’s the way it works: A handle points to a pointer, which in turn points to a
data structure somewhere in memory. If the Mac needs to move that data struc-
ture, the Mac relocates it and then changes the value of the pointer. The handle’s
value never changes—it’s still pointing to the same pointer—and so the move-
ment is invisible to the program.

Handles carry the analogy of pointers directly: To access the data structure a
pointer points to, you say P?, that is, the pointer variable’s name followed by a
caret. For a handle, H” refers to the pointer that the handle points to, and HA
refers to the data structure.

Menus are managed using handles. All the menu procedures and functions
work with menu handles, such as GetMenu, SetltemMark, Enableltem, and
Disableltem. Since almost all menu manipulation is done via predefined rou-
tines, you should never have to directly access any field of the menu records.

Windows are managed in a two-fold way, with both a WindowPtr (MainPtr)
and a ‘WindowRecord (MainRec). MainRec is used in the initial call to GetNew-
Window, but is never really directly accessed. MainPtr, on the other hand, is
used in almost all the window-based calls. MainP¢r actually points to a structure
of type WindowRecord, but you can’t access it through MainPtr, since its
declared data type is GrafPtr. Instead, you need to do the assignment MainPeek
:= WindowPeek (MainPtr);, where MainPeek is defined to be of type WindowPeek
(which is equivalent to *WindowRecord). You can then access the Window-
Record fields via MainPeek”.

QuickDraw, the graphics package, has some of its own data structures, most
notably the types Point and Rect. Point is a variant record that allows you to refer
to its X and Y components either as separate fields (V, H) or as elements of an
array (VH/[0] and VH[1]). The type Rect builds upon that: You can access its four
coordinates as either separate fields (Top, Left, Bottom, Right) or as two points
(TopLeft, BottomRight), which in turn give you the options (V, H) or (VH[0],
VH[1]).
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There are many other predefined data types, as well as numerous predefined
constants. Most can be found by looking at the Macintosh Interface units in
Appendix D and at Inside Macintosh, especially Volume 1.

Resource Files

There are two ways of defining windows, menus, and other data constructs spe-
cific to your program. First, you can use calls to NewWindow, NewMenu, and so
on, hardcoding the menu layout or window specs into the initialization section of
your program. Or, you can lay it all out in a resource file, compile it using
RMAKER, and link it into your program. Your initialization section can then
load in the menu, window, and other information from the resource section of
the application.

A resource file contains items of different resource types: STR (string), ICON
(icon), MENU (menu), WIND (window), DLOG (dialog box), and so on. Each
item is associated with a resource ID, such as 1000, 1001, and so on. These IDs
need to be unique within a type; you can’t have, say, two menus with IDs of
1000. But you can have the same numbers as IDs for different types. For exam-
ple, in the following resource file example, there are several items with
ID=1000, but all are of different resource types:

EXAMPLE
TYPE MENU ; menus
,1000 resource ID
\14 menu title (=RApple logo)

first item
second item: line separator

About My Demo...
(_

.o we wo we =

,1001 ; resource ID
File ; menu title
New ; first item
Open
Save
Quit
,1002 ; resource ID (another menu)
Edit ; menu title
Undo/2 ; first item (with character command equiv)
(- ; line separators
Cut/X ; and so on...
Copy/C
Paste/V
Clear

(_
Show Clipboard

; more menus go here

Writing Your Own Macintosh Applications 97



TYPE WIND ; Wwindow

, 1000 ; resource ID
My Demo Progranm ; window title
44 7 335 505 ; coordinates: yl,x2, y2,xe
Visible GoAway ; window attributes
1] ; window type = documentProc
0 ; refCon: user-definable info
TYPE DLOG ; dialog box

,1000 ; resource ID
About My Demo ; box title
90 SO0 180 460 ; coordinates
Visible NoGoAway ; attributes
16 ; window type = rDocProc
0 ; refCon
1000 ; ID for dialog item list
and so on.

These IDs are used when you want to read the resource items from within
your program.

How do you associate a given resource file with a program? Two steps are
necessary. First, the very first line in a resource file names the file that the
compiled resources should be written out to; by convention, that file has the
extension .RSRC. Second, having run RMAKER on your resource file, you need
to pull the resulting data file into your program when it compiles. You do that
using the {$R (file)} compiler directive (not to be confused with the {$R+/-}
range-checking directive). For example,

{$R Example.Rsrc}

tells Turbo Pascal to copy in the resources from EXAMPLE.RSRC whenever it
compiles a program. If you compile to disk, then the resource information is
placed in the resource fork of the resulting application. That way, you can move
and copy the application as much as you'd like, and the resources automatically
go with it.

There are two other compiler directives that tie into using resources. The first
is the {$B+} directive, which sets the bundle bit. Briefly, the bundle bit tells the
Mac desktop that the resources in your application should be installed and used
as a group. This applies primarily to icons and file types. Using it allows you to
define your own icon in your resource file, as well as icons for files produced by
your application.

The second directive is the {$T (filetype)}, which is used to define the file type
and file creator for your program. The file type should (usually) be APPL, since
you are producing an application. The file creator has two uses. First, it associ-
ates the application with an icon; second, it allows a document to invoke your
application when it’s double-clicked, if the document is associated with the cre-
ator type of your program. Again, this all ties in to the bundle concept.
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Chapter 12 tells you how to use RMAKER and the format needed for your
resource file. Additional information about resources can be found in Inside Mac-
intosh, Volume I, Chapter 5, and Volume III, Chapter 1.

Initialization

Like the overall program, the initialization procedure for most Macintosh pro-
grams follows a certain structure:
¢ Call Init routines.
* Set up menus.
* Set up windows.
* Do other graphics initialization.
* Do program-specific initialization.
* Handle clicked documents.
There is an Init routine for most of the major managers. The first, and most
important, is InitGraf{@thePort). That sets up QuickDraw (which is used by

just about everything else) and sets up a grafport for the screen. Other Init
routines you’ll probably want to call are

InitGraf(@thePort); { create a grafport for the screen }
InitFonts; { start up the font manager }
InitWindows; { start up the window manager }
InitMenus; { start up the menu manager }
TEInit; { start up the text manager for DAs }
InitDialogs(NIL); { start up the dialog manager }
FlushEvents(everyEvent,0); { clear events from previous state }

Setting up menus involves four steps. First, you want to define the menus
themselves. If youre using a resource file, just do a call to GetMenu for each
menu handle, or even a single call to GetNewMBar. Otherwise, you have to
build each menu using an initial call to NewMenu, followed by a call or calls to
AppendMenu. Second, if you're handling desk accessories, call AddResMenu, as
described earlier in this chapter. Third, add all the menus to the menu bar by
making successive calls to InsertMenu. Finally, call DrawMenuBar to display
the menu titles and make them active, as in
MenuList[1] := GetMenu(ApplMenu); { read menus in from resource }
MenuList[2] := GetMenu(FileMenu);

MenuList(3] := GetMenu(EditMenu);
{ get other menus in like fashion }

AddResMenu(MenuList[11,‘DRVR’); { pull in all desk acccessories }

for Indx := 1 to MenuCnt do { place menus in menu bar }
InsertMenu(MenulList(Indx1,0);

DrawMenuBar; { draw updated menu bar to screen }
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In addition to all that, you may want to make calls to Disableltem to disable
any commands that shouldn’t be active when your program starts, such as edit-
ing commands (when no editing windows are open).

As with menus, your window initialization takes several steps. If you need a
window at startup, create it using either GetNewWindow (reading in from
resources) or NewWindow (building it in place). In either case, you'll now have a
pointer to your window, which is what you'll use for most window manager calls.
Having created the window, make it the current grafport by calling SetPort,
then make it the active window by calling SelectWindow. If it has a drag bar,
define dragging limits (DragArea). Likewise, if it has a Grow box, define mini-
mum and maximum size (GrowArea); you should also call DrawGrowlcon. For
example:

{ set up window stuff }

GetWMgrPort(ScreenPort); { get grafport for all windows }
SetPort(ScreenPort); { and keep on hand just in case }
MainPtr := GetNewWindow(MainID,@MainRec,Pointer(-1)); { get window }
SetPort(MainPtr); { set window to current grafport }
SelectWindow(MainPtr); { and make window active }
FrontWindow := MainPtr; { remember that it’s in front }
DrawGrowIcon(MainPtr); { draw the Grow box in the corner }
MainPeek := WindowPeek(MainPtr); { get pointer to window record }
MainPeek®.windowKind := UserKind; { set window type = user kind (ID=8) }
Screenhrea := screenBits.Bounds; { get size of screen (don’t assume) }
with ScreenArea do
begin

SetRect(Draghrea,S,25,Right-5,Botton-10); { set drag region }

getRect(GrowArea,Sﬂ,ED,Right-S,Bottom-LD) { set grow region }
end;

There is a fair amount of graphics initialization you can, but don’t have to, do.
This includes setting pen size, pattern, and mode; loading the cursor, either from
the system or from your resource file; loading or defining patterns; loading icons
and bitmaps; and similar tasks.

Your program-specific initialization should probably come here. You've set up
all you need to in order to do some work; if your program requires it, you're able
to modify menus, windows, and other data structures and display elements.

The last part of initialization happens only if you have an application that can
be launched by opening a document associated with your application’s creator
type. For example, you can get into Turbo Pascal by double-clicking any program
file created under it. You can detect this by making the following call:

CountAppFiles(Msg,FCount);

This returns two values: FCount, which tells you how many files were
selected; and Msg, which tells you if the files were selected for printing or for
opening. You can then set up a loop (Indx := 1 to FCount) and call GetApp-
Files(Indx,AFRec), which will return information on each file to you, one at a
time. Once you've handled that file, you can remove it from the list by calling
ClrAppFiles(Indx).
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As is true with most aspects of Macintosh programming, the best way to learn
is to see what others have done. You'll find a diverse variety of approaches in the
sample programs on your Turbo Pascal disk(s); there’s something to be gleaned
from each one.

Cleaning Up

Cleaning up on the Macintosh is actually minor; most details are automatically
taken care of when you exit your program. There is a specific procedure,
ExitToShell, which you can (but don’t have to) call. It’s useful if you have to abort
in the middle of a program, although the Turbo Pascal routine Halt performs the
same function.

Large Programs and Segmentation

The Mac limits the code size of a program to 32,768 bytes. When you need to
write programs that exceed this limit, you must segment your program. This
means dividing it up into chunks of less than 32K bytes each.

Turbo Pascal makes segmentation simple. At the start of your program, tell the
compiler to produce a segmented code file by including the {$S+} compiler
directive.

This switch is off by default; you must explicitly turn it on to use segments.
When segmentation is off, all subprogram (procedure and function) calls and
subprogram address references are coded by the compiler using program coun-
ter-relative instructions. When segmentation is on and you’re using the {$S+}
directive, all calls and address references are routed through the segment loader
jump table.

To segment your program, organize your procedures and functions—including
those in a unit—into different segments. When you want to specify which seg-
ment a procedure, function, or group of procedures and functions should be in,
precede the specific item with the directive {$S segname}, where segname is a
string of up to eight characters.

NOTE: The $S directive is case-sensitive. {$S MySeg} and {$S mySeg} refer
to two different segments.

If segname is less than eight characters long, it will be padded on the right
with blanks. All procedures and functions following it will be included in that
segment until the next {$S segname} directive is encountered.
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The default segment, or blank segment, is one whose name consists of eight
blanks. This is where any procedures and functions declared before the first
{$S segname} directive are stored.

You can repeat segment names within a program, collecting procedures and
functions in different parts of the program into the same segment. You can also
organize your units into segments, as you saw in the last section of Chapter 8.

When you compile